Date:

Section
1

O 00 N N W b~ W N

VST NS TN NG NN NS T NG T NG I NS I NS B e e e e N e R e e
N N R WD = O VO 0NN N DR WD~ O

TraceCompass-3.0.0
2017/06/28

Content

Integration

Junit Tests

TMF - Project View

TMF - EventsEditor

TMF - BookmarksView

TMF - Filters View

TMF - Colors View

TMF - Histogram View

TMF - Sequence Diagram
TMF - Statistics View

TMF - Time Chart View

TMF - Custom Parsers

TMF - State System Explorer
TMF - Call Stack View

TMF - Remote Fetching
LTTng 2.0 - Control Flow View
LTTng 2.0 - Resources View
LTTng 2.0 - Control View
GDB Tracing

Tracing RCP

LTTng 2.0 - Memory Analysis
LTTng 2.0 - CPU Analysis
Trace Synchronization

XML analysis

Network Trace analysis
Critical path

LTTng 2.0 - I/O Analysis

Todo

3.0.0-TraceCompassTestCases - Summary

Pass

Fail

Total
23
18
148
25
17
12

6
50
38
18
26
28
14
24
52
52
40
131
25
32

22
25
13
40
11
45
19

Comments

:With comments
| With comments
| With comments
| With comments
| With comments
| With comments
| With comments
| With comments

With comments
With comments

With comments
With comments

With comments

With comments
With comments
With comments

With comments

With comments

With comments

SWTBot
0

18

73

(SN I O VS Rl Bl el RO, el )}

Lock held by...

Mikael

Bernd

Bernd

Manual Test Version

RC1 RCP
RC1 RCP
RC1 RCP

RC1 RCP
RC2 RCP (upgrade)
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC3 RCP
RC1 RCP
RC1 RCP
RC2 RCP (upgrade)
RC2 EPP
RC3 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP
RC1 RCP



3.0.0-TraceCompassTestCases - Summary

28 LTTng 2.0 - VM Analysis 39 | With comments 0 RC1 RCP
29 LAMI 18 0 RC1RCP
30 Flame Graph 19 With comments 11 RC1 RCP

Totat[ o0 | 1026 | 4 [ 1011

Open Fixed Total

Bug Reports



3.0.0-TraceCompassTestCases - Integration

To Do

Section Comment

Integration ““
Target:
Step Test Case Action Comment
1  Verify C/C++ EPP Package RC1
1.1 Download EPP Package Download, extract and start EPP package EPP Package starts Manual N/A
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
Go to Help -> About Eclipse -> Installion Details correct version (TMF, LTTng, CTF, GDBTrace) Manual N/A Not all tests were done this time for this milestone
1.3 TMF presence Open Tracing perspective Tracing perspective opens Manual N/A
1.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual N/A
1.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual N/A
Go to Help -> Install New Software... -> Update site "Oxygen - http: Verify that all LTTng Kernel, LTTng UST and GDB Trace are available
1.6 Oxygen Update Site /ldownload.eclipse.org/staging/oxygen/" Manual N/A
2 Verify C/C++ EPP Package RC2
Download, extract and start EPP package. Check the mailing list for the packe
2.1 Download EPP Package https://dev.eclipse.org/mailman/listinfo/epp-dev EPP Package starts Manual Pass
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
22 Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Manual Pass Not all tests were done this time for this milestone
2.3 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
2.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
2.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass
Go to Help -> Install New Software... -> Use the testing update site "Oxygen Verify that all LTTng Kernel, LTTng UST and GDB Trace are available
2.6 Oxygen Update Site - http://download.eclipse.org/staging/oxygen/" Manual Pass
3  Verify C/C++ EPP Package RC3
3.1  Download EPP Package Download, extract and start EPP package EPP Package starts Manual Pass
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
32 Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Manual Pass
33 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
3.4  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
3.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass
Go to Help -> Install New Software... -> Use the testing update site "Oxygen Verify that all LTTng Kernel, LTTng UST and GDB Trace are available
3.6  Oxygen Update Site - http://download.eclipse.org/staging/oxygen/" Manual Pass
4  Verify C/C++ EPP Package RC4
4.1 Download EPP Package Download, extract and start EPP package EPP Package starts Manual Pass
Verify that all tracing features and plug-ins are present and have the
Version of Tracing Features correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST,
42 Go to Help -> About Eclipse -> Installation Details CTF, GDBTrace) Manual Pass
4.3 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
4.4  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
4.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass
Go to Help -> Install New Software... -> Use the testing update site "Oxygen Verify that all LTTng Kernel, LTTng UST and GDB Trace are available
4.6 Oxygen Update Site - http://download.eclipse.org/staging/oxygen/" Manual Pass
5  Verify Update Site

Download Eclipse for Committers and install LTTng Kernel, LTTng UST,
GDBTrace and PCAP Network Analysis from main simrel testing Update site
5.1  Oxygen Update Site "Oxygen - http://download.eclipse.org/staging/oxygen/" Verify that installation was successful Manual Pass
Download Eclipse for Committers and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools
Update site
5.2 Trace Compass Update Site http://download.eclipse.org/tracecompass/oxygen/milestones Verify that installation was successful Manual Pass



5.3

5.4

5.5

6.2

Upgrade using Oxygen Update Site

Upgrade using Trace Compass Update
Site

Upragde from previous EPP

Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

3.0.0-TraceCompassTestCases - Integration

Download Eclipse for Committers from Oxygen.0 and install LTTng, LTTng
Kernel, GDBTrace and PCAP Network Analysis from main simrel Update
site.

http://download.eclipse.org/releases/neon

Try to update the installation using the testing simrel update site.

Oxygen - http://download.eclipse.org/staging/oxygen/

Download Eclipse for Committers from Oxygen.0 and install LTTng, LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Trace
Compass release Update site.
http://download.eclipse.org/tracecompass/releases/2.3.0/repository

Try to update the installation using the Trace Compass update site http:
/ldownload.eclipse.org/tracecompass/oxygen/milestones

Download Eclipse previous C/C++ EPP package. Try to upgrade using both
update sites:

(TODO find correct job: https://hudson.eclipse.org/packaging/job/luna.epp-
tycho-build/128/artifact/org.eclipse.epp.packages/archive/repository/)
"Mars - http://download.eclipse.org/releases/maintenance"

The information about the update sites to use is usually posted on epp-dev
Rel outside rel train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTng
UST, GDBTrace and PCAP Network Analysis from main
Update site: http://download.eclipse.org/tracecompass/stable/repository/

Download Eclipse standard from Luna SRO and install LTTng, LTTng Kernel,
LTTng UST, GDBTrace and PCAP Network Analysis from the Luna SRO
Linux Tools Update site.

http://download.eclipse.org/linuxtools/update-3.1

Try to update the installation using the Trace Compass update site.
http://download.eclipse.org/tracecompass/stable/repository/

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Manual

Manual

Manual

Manual

Manual

N/A

N/A



3.0.0-TraceCompassTestCases - JUnits

Section Pass Fail ToDo Comment

Junit Tests 18 “ 0

Target: Ubuntu 12.04 64 bit and on Hudson

Step Test Case Action Verification Comment

1 Junit Test Cases

1.1 CTF Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.2 CTF Parser Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.3 State System Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.4 TMF Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.5 TMF Ul Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.6  TMF UI SWTBot Tests Plug-in Run manually or with Jenkins All test cases passed Pass
CTF Support for TMF SWTBot

1.7 Tests Plug-in Run manually or with Jenkins All test cases passed Pass
TMF Xml Analysis Core Tests Plug-

1.8 in Run manually or with Jenkins All test cases passed Pass

1.9  TMF Xml Analysis UI Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.10 LTTng Control Core Tests Plug-in ~ Run manually or with Jenkins All test cases passed Pass

1.11  LTTng Control UI Tests Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Analysis Core Tests

1.12  Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Analysis UI Tests

1.13  Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Ul SWTBot Tests

1.14  Plug-in Run manually or with Jenkins All test cases passed Pass

LTTng Userspace Tracer Analysis
1.15  Core Test Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Userspace Tracer Analysis Ul
Test Plug-in Run manually or with Jenkins All test cases passed Pass

>

GDB Tracepoint Analysis Core Tests

1.17  Plug-in Run manually or with Jenkins All test cases passed Pass
GDB Tracepoint Analysis Ul Tests

1.18  Plug-in Run manually or with Jenkins All test cases passed Pass



3.0.0-TraceCompassTestCases - ProjectView

Section Pass Fail Type ToDo Comment

TMF - Project View 148 | 3 [ o iz

Target: Ubuntu 16.04 64 bit

Step Test Case Action Verification Comment
1 Preparation
1.1 Step 1 Open LTTng Kernel perspective LTTng perspective opens with correct views SWTBot Pass
1.2 Step 2 Open Navigator View (used for independent verification) Navigator View opens SWTBot Pass
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot Pass
22 Create project Specify a project name and finish Tracing project appears in Project Explorer/Navigator SWTBot Pass
23 Project structure Open the new Tracing project Project contains Experiments and Traces folders SWTBot Pass
3 Traces Folder

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml, ExampleCustomTxtParser.
xml) from directory traces/customParsers into your
workspace from the Manage Custom Parsers dialog.

Preparation SWTBot Pass
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Import, Refresh) SWTBot Pass
32 Trace Import Wizard Select Import Trace Import Wizard appears SWTBot Pass

1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import unrecognized traces",
unselect "Overwrite existing without warning" and select "Create

Import single custom text trace (link to Links to workspace" and Imported trace appear in Traces Folder and the Trace Type Tmf

33 workspace) 4) press Finish Generic is set. Make sure trace can be opened SWTBot Pass
Import Single custom XML trace (link Imported trace appear in Traces Folder and the Trace Type

3.4 to workspace) redo 3.1-3.3 but this time select ExampleCustomXml.xml "Custom XML log" is set. Make sure that trace can be opened SWTBot Pass
Import LTTng Kernel CTF trace (link Imported trace appear in Traces Folder and the Trace Type

3.5 to workspace) redo 3.1-3.3 but this time select directory kernel-overlap-testing/ "LTTng Kernel" is set. Make sure that trace can be opened SWTBot Pass

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to workspace"
Traces are imported with new name that has a suffix (2) at the

3.6 Rename + copy import When dialog box appear select Rename end. Make sure that imported traces are copied to the project. SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to workspace" Existing traces are deleted and new traces are imported. Make
sure that imported traces are copied to the project and can be
3.7 Overwrite + copy import ‘When dialog box appear select Overwrite opened SWTBot Pass

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to workspace"

3.8 Skip ‘When dialog box appear select Skip Make sure that no new trace is imported SWTBot Pass

Make sure that no dialog box appears (for renaming,
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to workspace" and overwriting, skipping) and existing traces are overwritten).
39 Default overwrite select "Overwrite existing without warning" Make sure trace can be opened SWTBot Pass

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import unrecognized traces",

unselect "Overwrite existing without warning" and select "Create unrecognized.log is imported with trace type unknown. The
Links to workspace" and default text file icon is displayed. The trace, when opened, is
3.10 Import unrecognized 5) press Finish displayed in the text editor. SWTBot Pass

redo 3.10, however unselect "Import unrecognized traces"
3.11 Import unrecognized (ignore) unrecognized.log is not imported SWTBot Pass



3.12

3.13

3.14

3.15

3.16

3.17

3.18

Preparation

Import CTF trace by selection
metadata file only

Preparation

Recursive import with auto-detection
(Rename All)

Preparation

Recursive import with auto-detection
(Overwrite All)

Preparation

Recursive import with auto-detection
(Skip All)
Preparation

Recursive import with auto-detection
(test rename, overwrite and skip)

Preparation

Recursive import with specific trace
type 1 (Skip All)
Preparation

Recursive import with specific trace
type 2 (Skip All)
Preparation

3.0.0-TraceCompassTestCases - ProjectView

Delete all traces in project - Right mouse click on Traces
folder and select "Clear"

Redo 3.5, However only select metadata file instead of directory trace
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized traces",
unselect "Overwrite existing without warning", select "Create Links
to workspace" and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized traces",
unselect "Overwrite existing without warning", select "Create Links
to workspace" and unselect "Preserve Folder Structure”

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized traces",
unselect "Overwrite existing without warning” and select "Create
Links to workspace" and uncheck "preserve folder structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized traces",
unselect "Overwrite existing without warning", select "Create Links
to workspace" and unselect "Preserve Folder Structure”

5) press Finish

6) When dialog appears select "Rename"

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve Folder
Structure"and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve Folder
Structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

SWTBot

Imported trace appear in Traces Folder and the Trace Type

"LTTng Kernel" is set. Make sure that trace can be opened SWTBot

All Traces are imported with respective trace type set. Traces
with name clashes are imported with suffix (2). 1 trace
(unrecognized.log) is imported with trace type unknown. Make
sure that traces can be opened which have a trace type set. The

unknown trace type should open with the text editor. SWTBot

All Traces are imported with respective trace type set. Traces
with name clashes are overwritten . 1 trace (unrecognized.log)
is imported with trace type unknown. Make sure that traces can
be opened which have a trace type set. The unknown trace type

should open with the text editor. SWTBot

All Traces are imported with respective trace type set. Traces
with name clashes are not imported. 1 trace (unrecognized.log)
is imported with trace type unknown. The unknown trace type

should open with the text editor. SWTBot

All Traces are imported with respective trace type set. Traces
with name clashes are either renamed, overwritten or skipped
as per dialog action. Make sure that traces can be opened which
have trace type set. The unknown trace type should open with

the text editor. SWTBot

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

4 CTF traces are imported with trace type "Generic CTF Trace"

. Make sure that these traces can be opened SWTBot

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace type "LTTng
Kernel Trace". Make sure that this trace can be opened.

SWTBot



3.19

3.20

3.21

3.22

3.23

3.24

3.25

3.26

3.27
3.28

3.29

3.30

Recursive import with specific trace
type 3 (Skip All)
Preparation

Recursive import with specific trace
type 4 (Skip All)
Preparation

Import wizard from workbench menu
with project selected

Import wizard from workbench menu
with no project selected

Preparation
Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

3.0.0-TraceCompassTestCases - ProjectView

1) Open Import wizard
2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import unrecognized After selecting trace type, verify that button "Import
traces", unselect "Overwrite existing without warning", select "Create unrecognized traces" is disabled.

Links to workspace" and unselect "Preserve Folder Structure"
5) press Finish
6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import unrecognized

traces", unselect "Overwrite existing without warning", select "Create

Links to workspace" and unselect "Preserve Folder Structure"
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing > Trace

Import
3) Browse to directory ${local}/traces/import/
4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to workspace" and

6) press Finish
1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing > Trace

Import
3) Browse to directory ${local}/traces/import/
4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection™, select "Create Links to workspace" and

6) press Finish
Delete all traces in project

D&D a few LTTng traces from another Tracing project's Traces folder

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

1) D&D a trace with name of an existing trace into traces folder
2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same destination folder
Open Import wizard
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite existing
without warning", select "Create Links to workspace" and select
"Preserve Folder Structure"

5) press Finish

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite existing
without warning", select "Create Links to workspace" and select
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Skip All"

3 LTTng UST traces are imported with trace type "LTTng
UST Trace". Make sure that these traces can be opened.

All text files in directories are imported as trace and trace type
"Tmf Generic" is set. Note that trace type validation only
checks for file exists and that file is not a directory. Make sure
that these traces can be opened. However traces with wrong
trace type won't show any events in the table.

Verify that trace is imported to "Test" project and can be
opened.

Verify that trace is imported to default "Tracing" project and
can be opened.

Selected traces are added to the Traces folder with proper icon.
Trace can be opened.

Selected traces are added to the Traces folder with default icon.
Files can be opened with the default editor.

Selected traces are added to the Traces folder with default icon.
For actual traces Trace type is detected automatically. Trace
can be opened, For non traces the files are added with default
icon and they can be opened with the default editor.

Verify that trace is added into the traces folder with the trace
name of the orignal trace plus a suffix 2
Verify that trace is added into the traces folder with the trace
name of the orignal trace plus a suffix 3

Verify that "Into Folder" text box cannot be updated

All Traces are imported with respective trace type set. The
folder "clashes" is imported with its traces inside. Make sure
that traces can be opened which have a trace type set.

The wizard should finish quickly as no trace will be imported.
Make sure that traces can be opened which have a trace type
set.

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual
Manual

Manual
Manual

SWTBot

SWTBot

ICTF traces (folders) are not supported yet



331

3.32

333

3.34

3.35

3.36

3.37

3.38

3.39

Recursive import with preserved
folder structure (Rename All)

Preparation

Delete with mixed selection of traces
and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no preserve
folder structure

Preparation

Import from zip archive specific traces
Preparation

Import from tar.gz archive, preserve
folder structure

Preparation

3.0.0-TraceCompassTestCases - ProjectView

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite existing
without warning", select "Create Links to workspace" and select
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Create two trace folders under the "Traces" folder

2) Import 2 traces under each folder

3) Open all 4 traces

4) Select one trace in the first folder and the second folder in the
Project Explorer view

5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces" folder

2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer view

5) Right-click, Delete. Click Yes

1) Import 2 traces from different folders preserving folder structure
2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite existing without
warning" and select "Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite existing without
warning" and unselect "Preserve Folder Structure”

5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt" and folder "kernel-
overlap-testing"

4) Select trace type "Automatic", and select "Preserve Folder
Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite existing without
warning" and select "Preserve Folder Structure"

5) press Finish

Delete all traces in project

All Traces are imported with respective trace type set with
suffix (2). The folder "clashes" is imported with its traces
inside. Make sure that traces can be opened which have a trace
type set.

A dialog should ask the user to confirm deletion of the selected
elements. Clicking OK should remove all that was selected.
The editor of the 3 deleted traces should be closed
automatically with one remaining editor opened.

A dialog should ask the user to confirm deletion of the selected
elements. Clicking OK should remove all that was selected.
The editor of both traces should be closed automatically.

A dialog should ask the user to confirm clearing of the folder.
Clicking Yes should remove everything under the selected
folder and close the traces

A dialog should ask the user to confirm clearing of the folders.
Clicking Yes should remove everything under the selected
folders and close the traces

All the files get imported under their respective folders. The
CTF traces can be opened (kernel-overlap-testing,
simple_server...)

All traces are imported with trace type set. The traces from
folder "clashes" are renamed with suffix (2). Make sure that the
traces can be opened

The specified traces are imported with trace type set. Make sure

that the traces can be opened.

All the files get imported under their respective folders. The
CTF traces can be opened (kernel-overlap-testing,
simple_server...)

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot



3.40

3.41

4.1
42
43
4.4
4.5
4.6
4.7

4.8

4.9

5.1
5.2

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9

6.10

6.11

7.1
72

73

7.4

7.5

7.6

7.1

Import from tar.gz archive, no

preserve folder structure

Preparation

Import from tar.gz archive specific

traces

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)
Open Trace (already open)

Experiments Folder
Experiments menu
Create experiment

Experiment
Experiment menu
Select Traces dialog
Select traces

Open experiment
Copy experiment
Rename experiment
Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)

Delete Experiment (open experiment)
Select Traces while Experiment is

open

Experiment Traces
Trace menu
Open trace

Remove trace

Drag and Drop from Traces

Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

3.0.0-TraceCompassTestCases - ProjectView

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.tar.gz
3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite existing without

warning" and unselect "Preserve Folder Structure"
5) press Finish

6) Select Rename All when dialog comes up.
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt" and folder "kernel-

overlap-testing"

4) Select trace type "Automatic", and select "Preserve Folder
Structure”

5) press Finish

Select an LTTng trace and open its context menu

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Reopen.
Select the Delete menu and confirm deletion

Select trace and press Enter

Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context menu
Select the New menu and provide experiment name

Select an experiment and open its context menu

Select the Select Traces menu

Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Open.
Select the Delete menu and confirm deletion

Select an Experiment and press Enter

Select an Experiment and press Delete and confirm deletion

Open an experiment, select expereiment and press Delete and confirm

deletion

Open an experiment and select an additional trace (see 6.3)

Select an LTTng trace and open its context menu
Select the Open menu

Open Experiment, select the Remove menu and confirm removal

D&D a few LTTng traces from the Traces directory

D&D a few LTTng traces from another Tracing project's Traces folder

D&D a few traces from a non-Tracing project

D&D a few traces from an external file manager

All traces are imported with trace type set. The traces from
folder "clashes" are renamed with suffix (2). Make sure that the
traces can be opened

The specified traces are imported with trace type set. Make sure
that the traces can be opened.

Correct menu opens (Open , Copy, Rename, ...)
Trace is opened and views are populated

Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Import XML Analysis, Refresh)
Experiment appears under folder, no traces yet

Correct menu opens (Select, Open , Copy, Rename, ...)
Select Traces dialog is open and populated w/ traces
Selected traces are imported in the experiment
Experiment is opened and views are populated
Experiment is replicated under the new name
Experiment is renamed

Experiment is deleted

Experiment is opened

Experiment is deleted

Experiment is closed and deleted

Experiment is closed and selected traces is imported to the
experiment

Correct menu opens w/ Copy disabled + Remove
Trace is opened and views are populated

Experiment is closed, trace is removed from experiment
Selected traces are added to the experiment with proper icon.
Experiment can be opened.

Selected traces are added to the experiment + Traces with
proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces with
proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces with
proper icon. Experiment can be opened.

SWTBot

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

Manual
Manual

Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Numpad-enter doesn't work

Loic Import XML Analysis renamed "Manage XML Analysis"

Numpad-enter doesn't work
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7.8

79

7.10

7.11

8.1
8.2
83
8.4

8.5

9.1

9.2

9.3

9.4

10

10.1

10.2
103

1"

11.1

11.2

11.3

11.4

115

11.6

11.7

Drag and Drop from external (non-
traces)

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)

Drag and Drop of trace while
Experiment is open

Propagation

Preparation

Rename propagation

Delete propagation

Propagate trace type 1

Propagate trace type 2

Properties View Synchronization

Trace synchronization

Other trace nodes synchronization
Check trace properties

Check trace properties - experiment
Trace Type Selection
Preparation

Trace properties
Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu
Delete Supplementary Files Action

Select and delete State History File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

3.0.0-TraceCompassTestCases - ProjectView

D&D a few files (non-traces) from an external file manager

1) D&D a trace with name of an existing trace into experiment folder

2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination folder

Open an experiment and D&D a trace from the Traces directory (see

7.4)

Copy experiment

In Traces folder, rename a trace showing in both experiments
In Traces folder, delete a trace showing in both experiments
Add a trace to 2 experiments. Change its type from Traces

Add a trace to 2 experiments. Change its type from one of the
experiments

Select a trace under a Traces folder in Project Explorer view. Repeat

with trace under an Experiment.

Select a Traces folder, Experiments folder, or an experiment in Project

Explorer view.

Open an LTTng kernel trace, click on the trace, check the new
properties view.

Open an experiment which contains LTTng kernel traces, click on the

experiment, check the new properties view.

Import an file with unrecognized trace type (${local}
/traces/import/unrecognized.log)

Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter for hidden resources (Coolbar
menu > Customize View... > unselect '.* resources)
2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to finish

a) Select trace under Folder Traces and click right mouse button
b) Redo test: Select trace under Experiment Folder

¢) Redo test: Select Experiment

1) Select trace and click right mouse button

2) Select 'Delete Supplementary Files...'

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select Delete Supplementary Files...'

Selected traces are added to the experiment + Traces with
proper icon (system icon). Experiment cannot be opened.

Verify that trace is added into the traces folder and experiment
folder with the trace name of the orignal trace plus a suffix 2

Verify that trace is added into the traces folder and experiemnt
folder with the trace name of the orignal trace plus a suffix 3

Experiment is closed and selected traces is imported to the
experiment

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected trace's
"Resource properties" Property and Value. The "Info > type"
property shows the selected trace category and trace type name.
The Properties view is updated with the selected item's Property
and Value. For Experiment verify the "type" property is set.

The "Trace properties" should be populated

The "Trace properties" should be populated for every subtrace

Imported trace appear in Traces with default icon. File is can be
opened by default Editor (either Eclipse text or system editor
depending on plug-ins installed)

Selected trace type is blank

Untyped trace does not appear in list

Verify that .tracing directory is shown under the project

Verify that StateHistory.ht is created under .tracing/<trace
name>/.

Verify that menu item 'Delete Supplementary Files...' is shown
in the context-sensitve menu

Verify that confirmation dialog box is opend and <trace
name>/StateHistory.ht is listed

Make sure that file .tracing/<trace name>/StateHistory.ht is
deleted from the project explorer view

Verify that two StateHistory.ht files are created under .
tracing/<tracel name>/ and ./tracing/<trace2 name>/
respectively. Also verify, that supplementatry folder for the
experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and shows 3 root
entries:

<exp name>, <tracel name> and <trace2 name>, with their
respective supplementary files below

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

SWTBot
Manual
SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

new name is not propagated and NPE Bug 517665. Fixed for 3.0.0

if done independently from line above

N/A New feature ... not implemented yet

SWTBot tries invalid type for a given valid trace, same thing.

now called org.eclipse. analysis.os.linux.kernel.ht
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11.8

11.9

11.10

1111

11.12

11.13

12

12.1

122

123

12.4

12.5

12.6
13

13.1

13.2

13.4

13.5

13.6

13.7

13.8

Select and delete State History File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace
Delete Supplementary Files Action

while trace is open
Link With Editor

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Trace Package Export Wizard

Preparation

Open the trace package export wizard

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

3.0.0-TraceCompassTestCases - ProjectView

Select one history file (<trace name>/StateHistory.ht) and click on 'Ok'

1)Redo 11.2 and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Open trace and then redo 11.4

1) In Project Explorer make sure that "Link with Editor" button is
selected
2) Open multiple traces and experiments

Select several traces and experiments one after each other in Editors
area

Select several open traces and experiments one after each other in
Project Explorer

1) In Project Explorer make sure that "Link with Editor" button is not
selected

2) Open multiple traces and experiments (if not open)

Select several traces and experiments one after each other in Editors
area

Select several open traces and experiments one after each other in
Project Explorer

1) Import 2 traces that generate supplementay files (trace2, kernel_vm)
2) Open both traces, wait for the indexing to finish

2) Add bookmarks in the two traces

Click on “File”, “Export...”, “Tracing”, “Trace Package Export” and
click Next

Alternatively, Right-click in Project Explorer on Project and select
"Export", “Tracing”, “Trace Package Export” and click Next
Alternatively, select multiple traces, right-click and select "Trace
Package Export"

On the left side, select the project in which the traces were imported.
Then on the right side, selected both traces.

With traces selected, press the Deselect All button. Then press on the
Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All. Then
click Select All again.

1) Click on the Browse button.

2) Select a location on the filesystem

3) Enter the file name export.tar

Make sure that the selected file .tracing/<trace

name>/StateHistory.ht is deleted from the project explorer view ~ Manual

Make sure that both history files are deleted under .
tracing/<tracel name>/ and .tracing/<trace2 name>/
respectively

Verify that supplementary directory .tracing/<trace name>/ is
deleted.

Verify that supplementary File StateHistory.ht .tracing/<tracel
name>/ and ./tracing/<trace2 name>/ are NOT deleted. Also
verify that the supplementary folder for the experiment .
/tracing/exp_name_exp is deleted.

Verify that supplementary File StateHistory.ht .tracing/<tracel
name>/ and ./tracing/<trace2 name>/ are NOT deleted

Verify that trace is closed and supplementary files are deleted

Verify that after each selection the corresponding trace or
experiment element is selected in the Project Explorer

Verify that after each selection the corresponding trace or
experiment is brought to the top in the Editors area

Verify that selection in Project Explorer doesn't change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects and traces to
select. Next button should be disabled.

Next should be become enabled when the first trace is selected.

If all traces are unselected, the Next button is disabled.

Next should become disabled after Deselect All, enabled after
Select All.

All elements in the trace tree are unselected, the Approximate
uncompressed size field changes to a lower number.

All elements in the trace tree are unselected, the Approximate
uncompressed size field changes to 0. The Next button is
disabled.

When Select All is clicked, all the tree elements are selected,
the approximate size increases. When Deselect All is clicked,
all the tree elements are deselected and the approximate size
decreases.

A file chooser dialog comes up. When the destination file is

entered, the “To archive file” is filed with export.tar.gz. The
Finish button should be enabled.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual
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13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16
14

14.1

14.2

143

144

14.5
14.6
14.7

14.8

14.9
14.10
14.11

14.12

14.13
15

15.1

Change export options, change
compression

Change export options, change format

Change export options, change format
and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

Preparation
Open the trace package import wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection
Trace sub-element selection

Select/Deselect All

Finish the wizard
Supplementary Files
Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

3.0.0-TraceCompassTestCases - ProjectView

Unselect the “Compress” checkbox.
Change to Zip format

Change to Tar format then select the Compress checkbox.

Click Finish

Open the wizard again and select the traces (step 13.2, 13.3). Click
Finish.

Open the wizard again and select the traces (step 13.2, 13.3). This
time, choose Zip format. Click Finish.

Open the tar.gz and the zip files in an archive manager.

Open the wizard again and select the traces (step 13.2, 13.3). This
time, unselect both Supplementary files subtrees. Click Finish.

Create an empty tracing project. Make sure you have export.tar.gz
available from the Trace Package Export Wizard (13) test case, which
should include everything including trace files, supplementary files
and export-manifest.xml.

Click on “File”, “Import...”, “Tracing”, “Trace Package Import” and
click Next

Click the Select button. Choose the previously created project.

1) Click on the Browse button.
2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button. Then press on the
Select All button.

Unselect the trace2 element
Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All. Then
click Select All again.

Click Finish
Right-click on trace2 in Project Explorer
Open the Bookmarks view

Double click on one of the bookmarks
Open the wizard again (step 13.2) and select the archive file (step

13.4). Click Finish.

Open Project Explorer view and Properties view. Create an empty
tracing project. Import two different traces to the project. Open the
traces and note their start time. Close the traces.

The name of the archive file changes to export.tar
The name of the archive file changes to export.zip

The name of the archive file changes to export.tar.gz

A progress bar should appear at the bottom the the dialog and it
should disappear upon completion. The export.tar.gz file should
be created on the file system.

The Archive file name should be remembered and already
filled. A dialog should prompt the user to overwrite. Answering
No should keep the wizard opened. Answering Yes should re-
export the archive and close the wizard.

The export.zip file should be created on the file system

In both archives, verify that it contains:

1) A trace folder for each trace containing all the trace files
(excluding supplementary files)

2) A .tracing folder containing all the 1 y files
3) An export-manifest.xml file listing the trace files,
supplementary files and bookmarks

Verify that the exported archive contains:

In both archives, verify that it contains:

1) A Traces folder containing all the trace files (excluding
supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace files and
bookmarks

The first page of the wizard should appear (Choose content to
import)

The Into project field gets filled with the selected project name.

Finish should be become enabled when the first trace is
selected. If all traces are unselected, the Next button is disabled.

Finish should become disabled after Deselect All, enabled after
Select All.

All elements in the trace tree are unselected.
All elements in the trace tree are unselected.
When Select All is clicked, all the tree elements are selected.

‘When Deselect All is clicked, all the tree elements are
deselected..

A progress bar should appear at the bottom the the dialog and it
should disappear upon completion. The two traces should
appear under the project in Project Explorer

Delete Supplementary files appears in the content menu
Bookmarks appear in the list for the imported traces

The corresponding trace opens at the bookmarked event.
Bookmarks are displayed in the event table.

A dialog should prompt the user to overwrite for each trace.
Answering Yes to All should overwrite without prompting
again.

SWTBot

SWTBot

Manual

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot
Manual

SWTBot

SWTBot
Manual
Manual

Manual

Manual

No File>export...>tracing in RCP, used Traces comtent menu

No File>export...>tracing in RCP, used Traces comtent menu

Very fast
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15.2

153

15.4

15.5

15.6

15.7

15.8

15.9

15.10

15.11

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog - experiment
selection

Apply time offset dialog - Basic mode

Apply time offset dialog - cumulative
offset

Clear time offset

Apply time offset dialog - Advanced
mode

Apply time offset dialog - Advanced
mode - compute from selection

Apply time offset dialog - Advanced
mode - compute from entered values

Clear time offset with opened traces

3.0.0-TraceCompassTestCases - ProjectView

Select both trace elements in the Project Explorer view. Right-click

and select Apply Time Offset...

Select the Traces folder element in the Project Explorer view. Right-

click and select Apply Time Offset...

Create an experiment with both traces. Select the experiment element

in the Project Explorer view. Right-click and select Apply Time
Offset...

Select a trace element in the Project Explorer view. Right-click and
select Apply Time Offset... In the Offset in seconds column, enter a

time with seconds and decimals. Click OK. Open the trace.

Select the same trace element in the Project Explorer view. Right-click
and select Apply Time Offset... In the Offset in seconds column, enter

a time with seconds and decimals. Click OK. Open the trace.

Select the trace element in the Project Explorer view. Right-click and

select Clear time offset. Click OK to confirm. Open the trace.

Open one trace and close the other trace. Select both trace elements in
the Project Explorer view. Right-click and select Apply Time Offset...

Choose the Advanced radio button.

Double-click the second trace to open it. Select an event in its trace
editor. Select the first trace editor. Select an event in its trace editor.
Click the button in the dialog row of the second trace. Click OK. Open

both traces.

Select the first trace element in the Project Explorer view. Right-click
and select Apply Time Offset... Choose the Advanced radio button.
Double-click the trace name to open it. Select the Reference time cell
and copy the start time. Select the Target time and paste the value. Edit
both values to different times. Click the button in the trace row. Click

OK. Open the trace.

Open both traces. Select both trace elements in the Project Explorer
view. Right-click and select Clear time offset. Click OK to confirm.

Open the traces.

The Apply time offset dialog opens in Basic mode. The Trace
name show both traces and the Offset in seconds is blank.

The Apply time offset dialog opens in Basic mode. The Trace
name show both traces and the Offset in seconds is blank.

The Apply time offset dialog opens in Basic mode. The Trace
name show both traces and the Offset in seconds is blank.

The timestamps in the trace are all offset by the entered value.
The Properties view shows the 'time offset' with the entered
value.

The timestamps in the trace are all offset by the cumulative sum
of the previous and current entered value. The Properties view
shows the 'time offset' with the cumulative value.

The timestamps in the trace are back to their original values.
The Properties view shows the 'time offset' as blank.

The Apply time offset dialog opens and is switched to
Advanced mode. The Trace name show both traces and the
Offset in seconds is blank. The Reference time for the opened
trace is set to its start time.

Both traces are open. Selecting an event updates the Reference
time for the selected trace, and updates the Target time for all
traces. Pressing the button computes the Offset in seconds as
the difference between Target time and Reference time for that
row. The trace which has a computed offset is closed when the
OK button is pressed. After reopening, the two previously
selected events now have the same timestamp. The Properties
view shows the 'time offset' with the computed value.

The trace is opened. The Reference time is set to the trace start
time. The Reference time and Target time can be copied,
pasted, and edited. Pressing the button computes the Offset
based on the current time values. The trace is closed with the
OK button is pressed. After reopening, the timestamps in the
trace are offset according to the computed value. The Properties
view shows the 'time offset' with the computed value.

The opened traces are closed when the OK button is pressed.
After reopening, the timestamps in the traces are back to their
original values. The Properties view shows the 'time offset' as
blank.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

With context switch traces
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Section
TMF - Histogram View

Target: Ubuntu 14.04 64 bit

Step

1
1.1
1.2

2.1
2.2
23

3.1
32

3.10

4.1
42

3.10
5
5.1

Test Case

Preparation
Step 1
Step 2

Manage View
Close view
Open view
Resize

Full Trace Histogram
Single selection
Range selection

Drag zoom window
Move zoom window
Set zoom window
Zoom in/out

Arrow keys
Home/End keys
Lost events

Zoom in/out (key)
Time Range Histogram

Single selection

Range selection
Drag zoom window
Zoom in/out

Arrow keys
Home/End keys
Lost events

Zoom in/out (key)
Selection Start/End
Set selection start

3.0.0-TraceCompassTestCases - HistogramView

Pass

Action

Open and reset LTTng Kernel perspective
Open an LTTng trace

Close the Histogram View
Window > Show View > Tracing > Histogram

Resize the Histogram View width-wise

Select timestamp with left-click
Select time range with shift-left-click, shift-left-drag or left-drag

Drag the zoom window left/right with ctrl-left-drag or middle-drag
Move the zoom window with ctrl-left-click or middle-click

Set a new zoom window with right-drag

Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

With a trace containing lost events, click the "Hide lost events" toolbar
icon. Click it again.

Zoom in/out with +/- key

Select timestamp with left-click

Select time range with shift-left-click, shift-left-drag or left-drag

Drag the zoom window left/right with ctrl-left-drag or middle-drag
Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

With a trace containing lost events, click the "Hide lost events" toolbar

icon. Click it again.

Zoom in/out with +/- key

Enter a TS within the full range in Selection Start widget

Fail

Verification

LTTng Kernel perspective opens with correct views

Views are populated

Histogram View is removed from perspective
Histogram View is displayed and re-populated
Histograms are compressed/decompressed without loss

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated

Zoom window is dragged, won't go beyond full range

Zoom window is centered on click, won't go beyond full range

Zoom window is set, Window Span is updated, won't go beyond
histogram range

Zoom window is updated, Window Span is updated, won't go
below 2 ns, won't exceed full trace range

Selection (blue bar) moves to the previous/next non-empty
bucket

Selection Start/End moves to beginning/end of trace (i.e. start
time of last bucket is selected)

The lost events (red bars) are toggled on and off.

Zoom window is updated, Window Span is updated, won't go
below 2 ns, won't exceed full trace range

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated

Zoom window is dragged, won't go beyond full range

Zoom window is updated, Window Span is updated, won't go
below 2 ns, won't exceed full trace range

Selection (blue bar) moves to the previous/next non-empty
bucket

Selection Start/End moves to beginning/end of time range (i.e.
start time of last bucket is selected)

The lost events (red bars) are toggled on and off.

Zoom window is updated, Window Span is updated, won't go
below 2 ns, won't exceed full trace range

Selection Start + blue bars are updated

To Do

Comment

[ s [ o fu

SWTBot |

SWTBot

SWTBot
SWTBot

SWTBot |

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Tested with HistogramDataModelTest

Matthew: Interesting, | forgot about this feature

Matthew: We need to publish this feature more

selection range

84710
84710
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52 Set selection end

53 Set selection (linked)
54 Set invalid selection start
55 Set invalid selection end

3.0.0-TraceCompassTestCases - HistogramView

Enter a TS within the full range in Selection End widget Selection End + blue bars are updated Manual
Select the link icon. Enter a TS within the full range in Selection Start

widget Selection Start/End + blue bars are updated Manual
Enter a TS before the full range start in Selection Start widget Selection Start + blue bar set to first event Manual

Enter a TS after the full range end in Selection End widget Selection End + blue bar set to last event Manual

6.1 Set window span

6.2 Set large window span

6.3 Set invalid window span

Enter a span in Window Span widget Both Histograms are updated accordingly Manual
Enter an invalid span (too large) in Window Span widget Span set to full range Manual

Enter an invalid span (too small, negative, not a number) in Window
Span widget Span set to previous value Manual What is to small? 1ns seems to work

Time Range mouse
7.1 synchronization

Full Trace mouse
7.2 synchronization

Selection synchronization
7.3 (linked)

7.4 External synchronization

Click on the time range histogram. The time of the bucket at the

mouse position is selected. Other views are synchronized to the selected time Manual
Zoom Window is moved if selection is outside the current zoom
Cligk on'the full trace histogram. The time of the bucket at the mouse ) i i window and a time graph window is open (e.g. CFV). Otherwise
position is selected. Other views are synchronized to the selected time Manual zoom window stays.
Select the link icon. Enter a time within the full range in Selection
Start widget Other views are synchronized to the selected time Manual
Selection Start/End + blue bars in both histograms are updated to
In any other view that supports time synchronization, select a time. the selected time Manual

Time Range mouse
8.1 synchronization

Full Trace mouse
8.2 synchronization

Selection Start/End
8.3 synchronization

8.4 External synchronization

Select a time range in the small histogram (shift-left click, left-drag or Verify that the selected time range shows in both histograms, and

shift-left drag). in other views. Manual
Select a time range in the full histogram (shift-left click, left-drag, Verify that the selected time range shows in both histograms, and
shift-left drag). in other views. Manual
Zoom Window is moved if selection is outside the current zoom
window and a time graph window is open (e.g. CFV). Otherwise
Enter a time within the full range in Selection Start/End widget Other views are synchronized to the selected time range Manual zoom window stays.

In any other view that supports time range synchronization, select a Selection Start/End + blue bars in both histograms are updated to
time range. the selected time range Manual

Time Range mouse
9.1 synchronization

Full Trace mouse
9.2 synchronization

Window Span
9.3 synchronization

9.4 External synchronization

Select a zoom window in the small histogram (ctrl-left drag, middle-

drag, right-drag, mouse wheel up/down). Other views are synchronized to the new range Manual
Select a zoom window in the full histogram (ctrl-left drag, middle-

click, middle-drag, right-drag, mouse wheel up/down). Other views are synchronized to the new range Manual
Enter a new span in Window Span widget Other views are synchronized to the new range Manual

In any other view that supports range synchronization, select a new
zoom window. Window Span and both histograms are updated to the new range =~ Manual
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10.1

10.2

10.3

10.5

10.6
10.7

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)

Trace coloring
Close all traces

3.0.0-TraceCompassTestCases - HistogramView

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}
2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-

testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time
Select a time and new range
Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click the
"Activate trace coloring" toolbar icon. Click it again.

Close all trace editor tabs

View shows the last opened trace

Selection Start/End, Window Span and both histograms are
updated to selected time and new range.

View shows the last opened trace

Selection Start/End, Window Span and both histograms are
updated to selected time and new range.

View is updated to show selected trace. Selection Start/End,
Window Span and both histograms are set to the newly selected
time and range.

The colors in both Histograms and toggled on and off. When it is
toggled off, the legend disappears at the bottom and only one
color is used for non-lost events.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual
Manual
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Target:

Section
TMF - BookmarksView
Ubuntu 14.10 64 bit

3.0.0-TraceCompassTestCases - BookmarksView

Type

To Do

[ 2 | o |

Comment

22

2.3

24

2.5

2.6

2.7

2.8

2.9

3.1

3.2

3.3

3.4

3.5

Test Case

Preparation

Preparation step 1

Trace bookmarks
Show Bookmarks View

Open trace

Add Trace Bookmark

Open Trace Bookmark (1)
Open Trace Bookmark (2)
Open Trace Bookmark (3)

Delete Bookmark (from
table)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Experiment bookmarks

Create and open experiment

Add Experiment Bookmark

Open Experiment Bookmark

M

Open Experiment Bookmark
(@)
Open Experiment Bookmark

)

Action

Open and reset LTTng Kernel perspective

Select Bookmarks view (bottom folder)

Open an LTTng CTF Kernel trace

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the trace #1 and then double-click on bookmark in Bookmarks
view

Select bookmarks icon in event table right-click on icon and select
"Remove Bookmark"

Double-clicking bookmarks icon in event table.

Add a bookmark (see 2.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Create Experiment with 2 LTTng CTF Kernel traces in it and open
experiment

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the experiment #1 and then double-click on bookmark in
Bookmarks view

Verification

LTTng Kernel perspective opens with correct views.

Bookmaks view is shown

Views are populated. Verify that a Kernel events editor is
opened showing LTTng Kernel specific columns

Make sure that bookmark icon is shown on left site of the event
row and is added to the Bookmarks view with relevant
information (i.e. Description entered and correct trace resource)

Make sure that event with bookmark is selected and visible in
event table

Make sure that correct trace #1 is brought to top and correct
event with bookmark is selected in events table

Make sure that correct trace #1 is opened and correct event with
bookmark is selected in events table

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding Bookmark is removed from the Bookmarks view

Verify that an Events editor is opened showing LTTng Kernel
specific columns

Make sure that bookmark icon is shown on left site of the event
row and is added to the Bookmarks view with relevant
information (i.e. Description entered and correct experiment
resource)

Make sure that event with bookmark is selected and visible in
event table

Make sure that correct experiment #1 is brought to top and
correct event with bookmark is selected in events table
Make sure that correct experiment #1 is opened and correct
event with bookmark is selected in events table

SWTBot

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

No Edit menu in Trace Compass RCP

No Edit menu in Trace Compass RCP
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3.6

3.7

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

3.0.0-TraceCompassTestCases - BookmarksView

Select bookmarks icon in Events view, right-click on icon and select
"Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding Bookmark is removed from the Bookmarks view

Manual

Manual
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3.0.0-TraceCompassTestCases - FiltersView

Section Pass 11 ToDo Comment

TMEF - Filters View 12 [ 12 [ o |

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment
1 Open a trace to be filtered Trace is opened SWTBot SWTBot Pass
2 Open filter view Filter view is opened SWTBot SWTBot Pass

Create a filter on event type
3 and timestamp The filterview contains a filter on the event type and the timestamp SWTBot SWTBot Pass
3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter on the
4 timestamp oring field values Create the filter SWTBot SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with matches
6 node Create the filter SWTBot SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with contains
7 node Create the filter SWTBot SWTBot Pass

7.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass



3.0.0-TraceCompassTestCases - ColorsView

Section Pass 11 ToDo Comment

TMF - Colors View 6 | 6 | o Jo

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment
1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass
2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update their
3 Select a color and a filter colors (background and foreground) to the new ones SWTBot SWTBot Pass
4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
By clicking on up and down, the order of the displayed colors should
5 Change the color priorities ~ change SWTBot SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass



3.0.0-TraceCompassTestCases - SequenceDiagram

Section Pass Fail ToDo Comment

TMF - Sequence Diagram n“ 13

Target: Ubuntu 14.04 64 bit

Step Test Case Action Verification Type Comment
1 Preparation
1) Download traces.zip (if necessary) and unzip into a local
directory ${local}
2)Use traces simple-server-thread1 and simple-server- Note: UI tests are not SWTBot, but JUnit tests. Tests are
thread2 under traces/import/ for test cases below triggered programmatically right below the dialogs level

LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources, Statistics,
1 Open perspective Open and reset LTTng Kernel perspective Histogram, Properties, Bookmarks SWTBot

Open TMF Sequence Use menu Window — Show View — Other ... — Tracing —
12 Diagram View Sequence Diagram Verify that 'Sequence Diagram' view is shown SWTBot

1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-thread1 and simple-server-thread2 Verify that sequence diagram was loaded. The interaction show
4) Add these 2 traces to experiment the signal numbers (Note that trace doesn't contain strings for
Create and open experiment  6) Open (double-click on) the experiment the interactions. A special parser would be necessary to map
3 with sequence diagram data signal number to trace) Manual

2 Manage View

2.1 Close view Close Sequence Diagram view Sequence Diagram View is removed from perspective Manual
Open view when 1) Close 'Sequence Diagram' View
experiment/traces is already ~ 2) load sequence diagram experiment Verify that sequence diagram was loaded. Verify that all 17
22 loaded 3) Open Sequence Diagram view pages are loaded. Manual difficult to get the numb of pages

w

Tooltip

Tooltip backgound is very dark and text is hard to read on
Ubuntu 13.10, 14.10 with default theme
1) Goto to first page (no selection of any interaction or lifeline) 2) Verify that tooltip appears with content with interaction name https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523. The
3.1 Hover over interaction Hover over first interaction (arrow or number) and time stamp (10000 14:58:00.740995147) Manual value is not the same

Verify that tooltip appears with content with interaction names

1) Goto to first page and time stamp delta between selected interaction and
Hover over interaction after ~ 2) select first interaction interaction that was hovered over (10001 — 10000 delta:
32 selection 3) Hover over 3rd interaction 000.000 157 023) Manual
Verify that tooltip appears with delta and graph to show where
Hover over time compression Hover over first element in time compression bar on the left of the delta is in relation to current configured min max values. (delta:
33 bar view 000.000 3 480) Manual

4 View Synchronization

Verify that interaction is highlighted in 'Sequence Diagram'
view. Verify that in the events table the corresponding event is
4.1 Selection of interaction Select an interaction in the 'Sequence Diagram' selected. Verify that time stamps matches Manual

Selection of event in events  Select an sequence diagram event in the events table (type SEND or  Verify that corresponding interaction is selected in the
42 table RECEIVE) 'Sequence Diagram' view Manual

It's a bit unclear to me what this is supposed to do. I think it
means when the start of the range changes, it should update
the events shown in the sequence diagram

Bernd: I updated the description to clarify for the next release.

Verify that the content of the 'Sequence diagram' changes and
43 Selection of new time range ~ Change time range in 'Histogram View'. the interactions are part of the new window range Manual

5 View Actions

Verify that different time ranges are selected when changing
page by looking at Histogram View. Histogram View window
will show the start of the page. Note that there are 10000
Use buttons and menu items 'Go to next page', 'Go to previous page',  interactions per page. In this traces there are in total 160032
'Go to last page' and 'Go to first page' to navigate through trace. Use  interactions. Verify that last page has 32 interactions between 2
1 Test page navigation also menu item 'Pages..." to jump to specific page lifelines. Manual

Where is the total number of interaction by page. Do we have to
verify that also?

w



52

53

54

5.5

5.6

5.7

5.8

59

5.10

5.11

5.12

5.13

5.14

5.15

5.16

5.17

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Reset zoom

Configure min/max

Configure min/max (default)

Show node end

1) Select menu item 'Pages..."
2) In text box type “9”
3) Click on 'OK'

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse

2) open find dialog

1) Select 'Sequence Diagram' view
2) pres CTRL+F

Goto to page 1 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns..."
3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate zooming in
2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to selection mode

2) select an interaction

1) Use button and menu item for zoom-out to activate zooming out
2) click into sequence diagram view

1) Use button and menu item for 'Reset zoom factor' to reset the zoom

level

1) Select menu item 'Configure Min Max'
2) Change min to 100 and max to 2000 (keep scale and precision)
3) press 'Ok’

After changing min and max
1) select menu 'Configure Min Max'
2) press 'Default' 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not shown
2) select on interaction

3) Use menu item Navigation — Show node end

3.0.0-TraceCompassTestCases - SequenceDiagram

Verify that a dialog box will show. Verify that for this trace it
shows 'Total: 17 pages is shown” and the current page is
displayed in the text box. After step 3) verify that page where
changed to page 9. For this trace page 9 is the page with 3
lifelines.

After 4) verify that interaction 10000 (player] — master) is
selected. After 5) verify that interaction 10100 (master —
playerl) is selected. After 6) verify that 10000 (player2 —
master) is selected. After 7) verify that interaction 10100
(master — player2). After 8 nothing else will be found

After 4) verify that lifeline with name player?2 is selected (page
9 with 3 lifelines). After 5) player2 is selected on page 10

Verify that previous used find criteria are still in the list

Verify that find dialog opens

After 5) verify that Interactions with name 10003 and 10103
are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note that no
selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note that no
selection is possible.

Verify that 'Sequence Diagram' view goes back to default zoom

After 1) verify that a dialog box shows with default values.
After 3) verify that time compression bar changes some colors.
It will show more deeper red because the max value is lower.

After step 2) the default values are shown. After step 3) the
time compression bar will change colors. Note that the default
values are computed based on all deltas of 2 consecutive
interactions.

Verify that end lifeline of the interaction (the arrow) is shown

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

It should have a string status in the search that specify that the
nothing was found. In the test 34, if the user search for "10.
*03" the find dialog will show "String not found". It should be
shown for this test too.

It reaches the right pages but the selection does not highlight
anything when the find box is still opened. It only highlight
the lifeline when we close the find dialog.

Bernd: It supposed to highlight the lifeline on the correct page.
So, test is successful. JC: The selection highlight the lifeline
but it is difficult to see.
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5.18

5.19

5.20

5.21

5.22

5.23

524

5.25

5.27

Show node start

Show node end short-cut

Show node start short-cut

Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug 391714)

Time Sync. without
interactions (Bug 391716)

Goto to page 1 —

1) Resize view so that the beginning of the interactions are not shown
2) select on interaction

3) Use menu item Navigation — Show node start

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not shown
2) select on interaction

3) Press SHIFT+ALT+END

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not shown
2) select on interaction

3) Press SHIFT+ALT+HOME

Press SHIFT+ALT+ARROW_DOWN

Press SHIFT+ALT+ARROW_UP

Goto page 9 — Keep pressing + icon at the lowest right corner of the
view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the Eclipse's
tool bar (or use CTRL+P). Select one pager page to print

1) Create Ifilter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

1) Open trace without any sequence diagram information
2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

5) Change time current selected time in Histogram View

3.0.0-TraceCompassTestCases - SequenceDiagram

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is shown

Verify that start lifeline of the interaction is shown

Verify that within a page the display scrolls down per view size

Verify that within a page the display scrolls up per view size

Verify that it's possible to navigate through a page of the
sequence diagram view

Verify that it is possible to print

Verify that no exceptions occurred and after 5) no filter are
listed

Make sure that no exceptions occurred

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

The shortcut is not working when the mouse is hovering the
interaction

The shortcut is not working when the mouse is hovering the
interaction

Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-settil (http://askubuntu
com/questions/171489/how-to-unbind-shift-alt-up-
shortke: 2-04)

After disabling this combination this test case
passes

On Ubuntu 14.04, 14.10, this is not an issue, by
default the keys are not mapped.

On Ubuntu, the movement is hectic and the overview box is
Very narrow.

On Mac OS X 10.8, the button is not visible but there is a
visible empty space that is clickable in its place. Clicking on it
brings up the overview box which has a reasonable size but
movement is still hectic.

Bug 436442

The dialog is confusing on Ubuntu. The "from pages" option
do not update directly the values you enter

‘Works on windows (including CTRL+P) Pass on 16.04 and 16.10

... could it be cups giving you a hard time?
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Target:

Step

1

1.1

N

w

E-Y

4.1

42

43
44
45

wv

-}

6.1

6.3

Section
TMF - EventsEditor

Test Case

Preparation

Preparation step 1

Trace bookmarks

Experiment bookmarks

Filter

Filter

Cancel filter

Un-filter
Filter & Search
Search & Filter

Time Synchronization
Mouse synchronization
Key synchronization
Search synchronization
External synchronization
Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

3.0.0-TraceCompassTestCases - EventsEditor

Pass

Action

Open and reset LTTng Kernel perspective

Moved to sheet "BookmarksView"

Moved to sheet "BookmarksView"

In the header row, enter some regex and press Ctrl+Enter

In the header row, enter some regex and press Ctrl+Enter, then quickly

press ESC before filtering is done

In the header bar, click the icon to delete a filter
In the filter bar, enter some regex; likewise in the search bar

In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp, PageDown,

Home, End

In the search bar, enter some regex, then search again with Enter/Shift-

Enter

In any other view that supports time synchronization, select a time.
Select an event with left button, press shift key and click select

another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp, PageDown,

Home, End

11

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and bottom
filter status rows update while filtering is ongoing. When
filtering is done, status rows show number of matching events.

Only some events matching regex are displayed. Status rows
show partial number of matching events, with different 'stop’
icon.

All events are displayed. Selected event remains selected and
visible. Status rows are removed.

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's time
Other views are synchronized to the selected event's time

Other views are synchronized to the selected event's time

The first event at or following the selected time is selected and
visible.

Range of events are highlighted. Selection range is updated in
other views that support range selection

Verify that an editor is opened showing LTTng Kernel specific
columns. Views are updated with the new trace.

The Properties view is updated with the selected event's
Property and Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's
Property and Value. Timestamp and Content are expandable.

Type

SWTBot

SWTBot

Manual

SWTBot
SWTBot
SWTBot

Manual
Manual
Manual
Manual

Manual

SWTBot

Manual

Manual

To Do

Pass

Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
2

Comment
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6.4

6.5

7.1

7.2

7.3

7.4

8.1

8.2

8.3

Search synchronization

External synchronization

‘Source Code / Model

Lookup

Preparation

Open call site

Open call site (no source
code)

Open model URI

Export to text

Export CTF trace

Export Other Trace

Copy to clipboard

Swap Columns and
Change Fonts

3.0.0-TraceCompassTestCases - EventsEditor

In the search bar, enter some regex, then search again with Enter/Shift- The Properties view is updated with the selected event's

Enter

In any other view that supports time synchronization, select a time.
The selected event in the editor is updated. Then give focus back to the

editor.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip

to your local disk.

3) Import demo C project to the Eclipse workspace of zip

file c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing

project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table
2) click right mouse button
3) select "Open Source Code" menu item

1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item

4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK.

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Copy to Clipboard" menu item
4) Paste it in a text file

Property and Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's
Property and Value. Timestamp and Content are expandable.

Verify that correct source code file and line number is opened

Since the source code is not available the no source code file is
opened. Instead a error dialog is opened (with title
"FileNotFoundException")

Since the model is not available the model element is not
shown. Instead a error dialog is opened (with title
"FileNotFoundException")

Make sure that a progress monitor dialog is opened during the
export. After finishing make sure that the text file exists and it
contains the events stored in the file. Verify that the columns
are printed as shown in the events table and that they are
separated by tab character.

Make sure that a progress monitor dialog is opened during the
export. After finishing make sure that the text file exists and it
contains the events stored in the file. Verify that the columns
are printed as shown in the events table and that they are
separated by tab character.

Verify that the columns are printed as shown in the events table
and that they are separated by tab character.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Used text trace
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9.1

8.2

83

Swap columns in events table

Change fonts

Reset fonts

1) Open a trace
2) Drag a column

1) Open the preferences
2) select new font for trace types

3) press apply
4) verify that the font changed

1) Open the preferences

2) Reset the font settings

3) Press apply

4) verify that the font changed

3.0.0-TraceCompassTestCases - EventsEditor

Covered by SWTBot tests

Covered by SWTBot tests

Covered by SWTBot tests

SWTBot

SWTBot

SWTBot
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Step

1

23

3.1

5

5.1

3.0.0-TraceCompassTestCases - StatisticsView

Section To Do Fail

To Do

Comment

TMF - Statistics View 18 [ 2 | o |2

Target: Ubuntu 14.04 64 bit

Test Case Action Verification Type
Preparation
Download traces simple-server-thread1 and simple-server-
Preparation thread1 from traces/import/
Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot
Use menu Window — Show View — Other ... — Tracing —
Open TMF Statistics View  Statistics Verify that 'Statistics' view is shown SWTBot
1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-threadl and simple-server-thread2 Verify that statistics are shown per trace and per event type.
4) Select trace type "Generic CTF Trace" Each trace has 80021 events. Verify that event types
5) Add these 2 traces to experiment ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
Open experiment are counted. Manual
Manage View
Delete view Close the 'Statistics' View Statistics' view is removed from perspective Manual
Open view Use menu Window — Show View — Tracing — Statistics Statistics' view View is displayed and re-populated Manual
Verify that statistics are shown per trace and per event type.
Open view when Each trace has 80021 events. Verify that event types
experiment/trace is already 1) Close 'Statistics View' 2) load trace above trace 3) Open 'Statistics'’ ENTER/RETURN/SEND/RECEIVE/INFO/after fork_child
loaded view are counted Manual
Other
Verify that 'Statistics' view is populated gradually during
Build of statistic index Open trace indexation Manual
Open same trace multiple times after indexing of trace was finished Verify that when opening the trace the x-times (x > 1), that the
Persistence of statistics the first time statistics appear right away without parsing the trace again Manual

Range Synchronization

External synchronization In any other view that supports range synchronization, select the full ~ Events in 'Events in selection' is updated and equals 'Events

(full) range of the trace. total' values Manual
External synchronization In any other view that supports range synchronization, select a new Events in 'Events in selection' is updated according to new

(range) range. range Manual
Multiple Trace

Synchronization

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-

testing

4) Create experiment with trace of 2) in it
Preparation Manual
Open multiple traces (no
overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Path is actually Window -> Show view -> Tracing -> Statistics
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52

5.3

5.4

5.5

5.6
5.7

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)

Close all traces

3.0.0-TraceCompassTestCases - StatisticsView

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab

Open multiple traces that overlap in time

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab
Close all Events editor tabs

Events in 'Events in selection' is updated according to new
range

View is updated to show selected trace. 'Events in selection' is
updated according to the selected trace's previously selected
range.

View shows the last opened trace
Events in selection' is updated according to new range
View is updated to show selected trace. 'Events in selection' is

updated according to the newly selected time and range.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual

Patrick: The pie chart doesn't know from which trace the event
comes from. Maybe we could skip events in the tree that have
zero count though?
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Section
TMF - Time Chart View

Target: Ubuntu 14.04 64 bit

Step

1
1.1
12

N

2.5
2.6

2.8
2.9

3.1

Test Case

Preparation
Preparation step 1

Preparation step 2

Trace handling

Open trace

Open other trace

Open experiment
Select other trace

Select other trace (external)

Close view
Open view

Close trace/experiment

Close last trace
Time Synchronization

Mouse synchronization
(single time)

Mouse synchronization (time Shift-left-click or left-drag on the time chart. The selected time range

range)

External synchronization
(single time)

External synchronization
(time range)

Zoom Range
Synchronization
Mouse wheel
synchronization
Mouse drag zoom
synchronization
Mouse drag move
synchronization
Mouse full range
synchronization

3.0.0-TraceCompassTestCases - TimeChartView

Pass

Action

Open and reset LTTng Kernel perspective
Show Time Chart View

Open an LTTng CTF Kernel trace #1

Open an LTTng CTF Kernel trace #2

Open an experiment
Select trace #1 by clicking its trace entry in Time Chart view

Select trace #2 by clicking its editor tab
Close the Time Chart view

Show Time Chart view

Close trace #2 editor tab. Repeat with experiment editor tab.
Close trace #1 editor tab

Left-click on the time chart. The selected time line is updated.

is updated.
In event table, select an event.

In event table, select an event range with shift-left-click.

Zoom in/out with mouse wheel while holding Ctrl.
Drag zoom with right-button on time chart.
Drag move with ctrl-left or middle button on time chart.

Double-click with left button on time chart's time scale.

11

Verification

LTTng Kernel perspective opens with correct views.

Time Chart view is shown

Trace #1 entry added to Time Chart view. Trace #1 is selected
entry. Range of view is full trace range.

Trace #2 entry added to Time Chart view. Trace #2 is selected
entry. Range of view is union of full trace ranges.

Experiment entry added to Time Chart view. Experiment is
selected entry. Range of view is union of full trace ranges.

Trace #1 is selected entry. View range does not change. Trace
#1 editor tab is brought to top.

Trace #2 is selected entry. View range does not change.
Time Chart view is removed from perspective

Time Chart view is displayed and re-populated with opened
traces data

Trace entry is removed from Time Chart view. Range is view is
union of remaining full trace ranges.

View is cleared.

Other views are synchronized to the selected time. Event at or
following the selected time is selected in the event table.

Other views are synchronized to the selected range. Event at or
following the selected time is selected in the event table.
Selected time line is updated to the event time. If necessary,

range is updated to show selected time.

Selected time line is updated to the time range.

Other views are synchronized to the new range
Other views are synchronized to the new range
Other views are synchronized to the new range

Other views are synchronized to the full range

Type

Type

SWTBot
Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

To Do

Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
0

Comment
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4.5

5.1
5.2
5.3
5.4

55
5.6

External synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark synchronization
Bookmark cleared

3.0.0-TraceCompassTestCases - TimeChartView

In any other view that supports range synchronization, select a new
zoom range.

Enter a search regex in event table
Clear the search regex in event table
Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

View range is updated to the new range

Matching events are marked in time chart

Marks are removed in time chart

Non-matching events are removed from time chart
All events are shown in time chart

Bookmarked event is marked in time chart
Mark is removed in time chart

Manual

Manual
Manual
Manual

Manual
Manual
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3.0.0-TraceCompassTestCases - Custom Parsers

Section
TMF - Custom Parsers
Target: Linux 64

Type To Do Comment

Step Test Case Action Verification Type Comment

0 Prerequisites

Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
0.1 Get custom parser definition and logs in /import

1 View management

Open and reset Tracing perspective, and open
1.1 Open perspective Time Chart view Time Chart view opens. SWTBot Pass

Create a tracing project, open Manage
Custom Parsers dialog and import text Custom parsers imported (TmfGeneric,
1.2 Import custom parser definitions and XML custom parser definitions Custom XML Log) Manual Pass
Traces imported in Traces folder of project
(ExampleCustomTxt.log,
Create a tracing project and import a text ExampleCustomXml.xml) and have their trace
1.3 Import custom traces and XML custom trace type auto-selected. Manual Pass

2 Custom parser management

Open Manage Custom Parsers dialog in
21 Open Manage Custom Parsers dialog Traces folder context menu Dialog opens. SWTBot Pass

Select "Text" radio button, click New...
button, enter Trace type, change stuff,

2.2  New (text) click Next, click Finish Custom parser appears in list. SWTBot | Pass
Select custom parser, click Edit..., change Previously entered data appears, can be

2.3 Edit (text) stuff, click Next, click Finish edited. SWTBot | Pass
Select custom parser, click Export, enter

2.4  Export (text) name, click Save Exported custom parser stored in file system. Manual Pass

2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted. SWTBot | Pass
Click Import, find custom parser definition,

2.6  Import (text) click Open Imported custom parser appears in list. Manual | Pass

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set ¢ to timestamp logged and d to
message logged, set timestamp format to
ss in both text boxes, click Next, click

2.7  New (XML) Finish Custom parser appears in list. Manual Pass
Select custom parser, click Edit..., change Previously entered data appears, can be
2.8  Edit (XML) stuff, click Next, click Finish edited. Manual | Pass
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3.0.0-TraceCompassTestCases - Custom Parsers

If you export to an existing .xml that is not an XML

Select custom parser, click Export, enter custom parser file, the export is ignored without

2.9  Export (XML) name, click Save Exported custom parser stored in file system. Manual warning to the user. Patrick: Bug 49054 opened.
2.10 Delete (XML) Select custom parser, click Delete Custom parser is deleted. SWTBot

Click Import, find custom parser definition,
211 Import (XML) click Open Imported custom parser appears in list. Manual

3 Custom parser trace handling

Select test file in Traces folder, right-click,

select "Select Trace Type > Custom Text Trace type is assigned (re-open Select Trace Or select the trace and verify the trace type in the

3.1 Select trace type (text) > (parser name)" Type sub-menu to verify) Manual properties view
Editor opens with events table, Time Chart
3.2  Open trace (text) Double-click on test file in Traces folder  view is populated. Manual
3.3  Raw view (text) Right-click in editor, click Show Raw Editor is split with raw view on right pane. Manual
Click in Time Chart view, select eventin  All three widgets synchronize to selected
3.4  Time synchronization (text) editor table, select event in raw view time. Manual selection in raw view is hard to see

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML Trace type is assigned (re-open Select Trace

3.5  Select trace type (XML) > (parser name)" Type sub-menu to verify) Manual
Editor opens with events table, Time Chart
3.6 Open trace (XML) Double-click on test file in Traces folder  view is populated. Manual
3.7 Raw view (XML) Right-click in editor, click Show Raw Editor is split with raw view on right pane. Manual
Click in Time Chart view, select eventin  All three widgets synchronize to selected
3.8 Time synchronization (XML) _editor table, select event in raw view time. Manual

4 Raw viewer should this be in events editor?

1) Open Custom text trace
2) Right-click in table and select "Show

4.1 Show Raw Viewer Raw" Raw viewer is shown beside the events table Manual
Right-click in table and select "Hide Events table is hidden and only raw viewer is

4.2  Hide Table Table" shown Manual
Right-click in raw viewer and select "Show

4.3  Show Table Table" Events table is shown beside raw viewer Manual

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
4.4  Select Event (Bug 457852) Select event in raw viewer event Manual

Correct event is select in table, timestamp is
1) select event in raw viewer with mouse  propagated to other TMF views and
Select Event using arrow keys 2) use arrow key down and up several Properties view shows content of selected
45 (457852) times event Manual

Raw viewer is hidden and only events table is
4.6 Hide Raw viewer Right-click in table and select "Hide Raw" shown Manual




Target:

2.1

22

23

2.4

2.5

2.7

2.6

2.7

3.1

32

4.1

42

Section
TMF - State System Explorer
Ubuntu 14.04 64 bit

Test Case

Preparation
Open TMF State System Explorer
View

Manage View
Delete view

Open view
Open Trace

Open view when trace is already
loaded

Open Experiment
Select other trace
Restart

Close all traces

Timestamp / Time Range Selection
Select timestamp

Select time range

Displaying of Changed Values

Highlighting of changed values
“Only Display Changes at Selected
Timestamp” option with event
selection

“Only Display Changes at Selected
Timestamp” with timestamp
selection

3.0.0-TraceCompassTestCases - State System Explorer

Action

Use menu Window — Show View — Tracing — State System
Explorer

Close the State System Explorer' View

Use menu Window — Show View — Tracing — State System
Explorer

Open an LTTng Kernel Trace

1) Close State System Explorer View
2) Load LTTng trace
3) Open 'State System Explorer' view

Open Experiment with 2 or more LTTng traces

Select different trace by clicking its Events editor tab
Restart Eclipse

Close traces and experiment one by one from the editor tab

Select time in another view (e.g Histogram view) that supports
time synchronization

Select a time range in another view that supports time
synchronization

Select many different timestamps one after the other

Enable the “Only Display Changes at Selected Timestamp”
option with the toolbar button. Select different Events from the
Event Table.

Enable the “Only Display Changes at Selected Timestamp”
option. Select *timestamps* corresponding to state changes (for
example, using the previous/next buttons in the Control Flow
View).

Fail

Verification

Verify that 'State System Explorer' view is shown

'State System Explorer' view is removed from perspective
'State System Explorer' view is displayed and re-populated

Verify that view is populated with kernel state system (o.e.t.analysis.os.linux.
kernel) and statistics state systems (o.e.l.tmf.statistics.*) of opened trace

Verify that view is populated with state systems from trace

Verify that view is populated with all kernel state system and statistics state
systems of opened experiment (separated by trace)

View is updated to show selected trace. State values, start time and end time are
updated according to the selected trace's previously selected range.

Verify that view is populated with state systems from trace

Verify that state system explorer view is cleared after closing the last trace

Verify that state values are updated

Verify that only the start of the range is taken in consideration (changing the end
time of the range should not affect the displayed values)

Attributes whose value changed in the last timestamp selection should be
highlighted in yellow.

Verify that only the state values that changed because of that event are displayed.

Verify that only the state values that changed at that timestamp are displayed.

Type

SWTBot

SWTBot
SWTBot

SWTBot

SWTBot

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

To Do Comment

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

Some state systems ID's should be renamed for Trace Compass

(if the state system were already built)
The values are only available for time ranges where the trace
exists. Only after we've "visited" other timestamps, then the
attributes show up and print "Out of range". http://eclip.se/443653

Bruno : I find the separation weird, and sincce I never used this
view i'd like someone else to test this item. (Only the items in the
second trace are expendable)

Test that will make this swtbot

84711

84711

84711

84711

84711
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Target:

Section
TMEF - Call Stack View
Windows 7 64 bit

Test Case

3.0.0-TraceCompassTestCases - Call Stack View

Action

Verification

To Do Comment

[ 14 | o |

Comment

1.3
1.4

2.1

22
23

2.4

2.5
2.7
2.6

2.7

3.1

32
33
3.4
35

4.1

42
4.3

Download the test resources

Preparation
Open TMF Call Stack View

Import generic trace

Import cyg-profile trace
Import cyg-profile-fast trace

Manage View
Delete view

Open view
Open Trace

Open view when trace is already loaded

Open Experiment
Select other trace
Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)
Zoom to function (time graph)

Go to first event in trace

Synchronization

Time synchronization

Event synchronization

Time range synchronization

Function name import - Text file

Download this

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Import a trace that does not have any call stack information, like a

standard kernel trace

Import the trace in the "trace" directory of the downloaded zip

Import a trace in the "trace-fast" directory of the downloaded zip

Close the Call stack view' View

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Open "trace(-fast)" trace
1) Close 'Call Stack' view

2) Open "glxgears-cyg-profile(-fast)" trace located in the git in ctf

test
3) Open 'Call Stack' view

Open Experiment with 2 or more Call Stack traces.
(You can use both traces)

Select different trace by clicking its Events editor tab
Restart Eclipse with Call Stack trace opened

Close traces and experiment one by one from the editor tab

Click on random time in the time graph pane

Click Previous/Next Event button
Double-click on a function in the table pane
Double-click on a function (interval) in the time graph pane

Go to events editor, press home

Select a random time in another view

Select a call stack-impacting event (function entry/exit) in events

table

Select a new time range in Histogram view.

Verify that 'Call Stack' view is shown

Verify that nothing is shown in the view, except “Stack info not available
(<tracename>)”

Verify that the Callstack View is populated with some callstack information.
Verify that the Callstack View is populated with some callstack information.

'Call Stack' view is removed from perspective

'Call Stack' view is displayed and re-populated

Verify that view is populated with call stack information

Verify that view is populated with call stack information

Verify that view is populated with all call stack information (separated by trace).
View is updated to show selected trace.

Verity that view is populated with call stack from trace

Verity that Call Stack view is cleared after closing the last trace

Selected time line is updated. Table is updated to show the full stack information
at the selected time. Selected time is updated in other views.

Previous or next call stack change is selected and corresponding active function
and stack depth is selected. Table is updated to show the full stack information at
the selected time. Selected time is updated in other views.

Time range is updated to the full duration of the selected function
Time range is updated to the full duration of the selected function

the call stack view is updated

Selected time line is updated. Table is updated to show the full stack information
at the selected time. If selected time is outside current range, time range is
updated to include it.

In addition to updating the selected time, the active function at the event time is
selected. Vertical scroll bar is updated if necessary.

Time range is updated.

SWTBot

Manual

SWTBot
SWTBot

Manual

SWTBot
SWTBot

SWTBot

Manual
Manual

Manual

Manual

SWTBot

SWTBot
SWTBot
SWTBot

Manual

SWTBot

SWTBot
SWTBot

Pass

Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass
Pass

Path is actually Window -> Show view -> Tracing -> Call stack

See comment 1.1. about the path

Fixed in https:/git.cclipse.org/t/#/c/80177/1

The vertical scroll bar is not updated(Sonia: only when you select
arendom time in the histogram view).If you select an event (in
another view)before the start of the calls, the vertical scroll bar
goes down.
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https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

5.1

52

6.1
6.2

Invalid text file import

Valid text file import

Function name import - CDT

Binary import
Binary import lttng 2.8+

3.0.0-TraceCompassTestCases - Call Stack View

Open 'trace’ from Fibonacci.zip. Click the "Select a mapping file"
button in the view and click "Browse" to select a random .txt file
that does not contain any debugging info.

Import a file "fibonacci.symbols"

Click the "Select a binary file" button in the view and click
"Browse" to select the fibonacci executable (fibonacci).

Open an lttng 2.8+ trace with the executable present

The function addresses do not change.

The view now displays function names instead of function addresses (both in the
timegraph and the call stack areas).

The view now displays the function names for both traces
The view now displays the function names for the trace

Manual

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.

France : I am not sure what to do here Sonia : The bug is resolved
, you can specify a mapping file for each trace if you have a
multiple traces in one experiment.

SWTBot

Sonia :you have to specify the binary file for each trace.The view

won't display the function names for the both traces if we select

the fibonacci executable for a trace in an experiment with multiple
Manual traces.

Manual
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Section
GDB Tracing

Target: Ubuntu 14.04 64 bit

Step

1
1.1
1.2

2.1
22
2.3

w

3.1
32
33

E-Y

4.1

42
43

wv

5.1

5.2

(-

6.1

6.2
6.3

6.4

7
7.1
7.2
7.3
7.4
7.5
7.6

GDB 7.11.1
Test Case

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project

Project structure

Traces Folder
Traces Folder menu
Trace Import Wizard
Import traces

Trace Configuration
Project/executable selection
Select Trace Executable
Open configured trace
Source Code Lookup
Select event

Select another event
Events Table Navigation
Arrow keys

Scrolling

PgUp/PgDn

Home/End

Events Searching & Filtering
Search

Navigation

Un-search

Filter

Filter & Search

Un-filter

Events Synchronization
Synch from Events View

3.0.0-TraceCompassTestCases - GDBTracing

Eclipse CPP EPP RC2
Action

Open and reset the GDB Trace perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish

Close and open the new Tracing project

Select the Traces folder and open its context menu
Select Import Trace
Select a GDB Trace from samples directory and finish

Double-click on an un-configured trace

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"
3) Fill in the proper values in dialog and finish

Double-click on a configured trace

With mouse select an event in events table

redo 5.1

Update the current event using up/down keys within window

Update the current event using up/down keys outside window

Update the current event using PgUp/PgDn keys

Update the current event using Home/End keys

In the search bar, enter some RE

Navigate through highlighted events using Enter/Shift-Enter
In the search bar, clear the RE

In the search bar, enter some RE and press Ctrl+Enter

In the filter bar, enter some RE; likewise in the search bar
In the filter header, remove the filter

Click on an event in the Events View

Verification

GDB Trace perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer

Project contains the Traces folder

Correct menu opens (Open Trace, Import, New Folder, ...)
Trace Import Wizard appears
Imported traces appear in Folders with proper icon

Verify that an Error Dialog opens that notfiies the user to select the trace
executable

Trace is configured (4.3 is successful, when 4.2 was successful)

Trace is opened, events table and views are populated

The corresponding source code location is selected in the source code file.

The corresponding source code location is selected in the source code file.

Each keystroke modifies the selected event and the corresponding source
code location is selected in the source code file.

Table is refreshed to display new current event and the corresponding source
code location is selected in the source code file

Table is scrolled accordingly

Table jumps from first to last event and the corresponding source code
location is selected in the source code file

Events corresponding to the RE are highlighted
Next/previous highlighted event selected accordingly
Events are displayed normally

Only events matching RE are displayed

Events are filtered and highlighted accordingly

Events are displayed normally

Trace Control View is updated; Debug View is updated

Type

Type

Manual
Manual

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Comment

Comment
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8.2

Synch from Trace Control

Go up/down from the Trace Control View

3.0.0-TraceCompassTestCases - GDBTracing

Events View is updated accordingly

Manual -
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Section
TMF - Remote Fetching

Target: Ubuntu 14.04 64 bit

Step

1.1

2.1
22

33
34
3.5
3.6
3.7
3.8

5.1
52

5.5
5.6

5.7
5.8
5.9

Test Case

Preparation
Step 1

Opening

Open Profile Editor 1
Open Profile Editor 2

Edit Profile - Add/Delete
Create Profile
Add Node

Add trace group

Add trace

Delete Trace

Delete Trace Group
Delete Connection Node
Remove Profile

Edit Profile - Reorder
Move profile up/down
Move connection node up/down
Move Trace Group up/down
Move Trace up/down
Edit Profile - Copy, Cut, Paste
Copy/Paste Profile

Copy/Paste Profile (Keys)

Copy/Paste Connection Node

Copy/Paste Connection Node
(Keys)

Copy/Paste Trace Group
Copy/Paste Trace Group (Keys)

Copy/Paste Trace
Copy/Paste Trace (Key)
Cut/Paste

3.0.0-TraceCompassTestCases - TMF - Remote Fetching

Pass

Action

Open Trace Compass and reset Lttng perspective

Right-click on Traces Folder -> Fetch Remote Traces ... -> Manage
Profiles

Window -> Preferences-> Tracing -> Remote Profiles

Open Profile Editor > Click on 'Add' > Enter profile name, remote
information, root path and trace pattern

Select Profile node > right mouse click > select 'New Connection
Node'

Select node node > righ mouse click > select 'New Trace Group'
Select trace group > right mouse click > select New Trace'
Select trace > right mouse click > select Delete

Select Trace Group> right mouse click > select Delete

Select Connection Node > right mouse click > select Delete
Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and press buttons 'Move
Up'/'Move Down'

Make sure that there are 2 or 3 connection nodes > select 1
connection node > click buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus > select 1 trace group >
click buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace groups > select 1 traces > click
buttons 'Move Up'/'Move Down'

Select Profile > click right mouse button on a profile > Select Copy -
> click right mouse button on other profile > Select Paste

Redo 5.1 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Connection Node >
Select Copy -> click right mouse button on other Connection Node >
Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a Trace Group > Select

Fail

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens
The Profile Editor of preference page opens

New Profile is created and template is provided

New Connection Node is create under the profile and template is
provided

New Trace Group is created under the node and template is
provided

New Trace is created under Trace Group and template is provided
Trace is deleted

Trace Group is deleted

Connection Node is deleted

Profile is deleted

Profiles are moved up and down
Connection Nodes are moved up and down within a profile
Trace Groups are moved up and down within a connection node

Traces are moved up and down within a Trace Group

Profile is pasted under the selected profile
Profile is pasted under the selected profile

Profile is pasted under the selected Connection Node

Profile is pasted under the selected Connection Node

Copy -> click right mouse button on other Trace Group > Select Paste Profile is pasted under the selected Trace Group

Redo 5.5 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Trace > Select Copy ->
click right mouse button on other Trace > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Redo 5.1 - 5.8 with cut and paste

Profile is pasted under the selected Trace Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace

Successful cut and paste

To Do
15 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass

Comment
9

Comment

Bruno : Not this test, but the Fetch Remotes
Traces dialog, has a help button that does
nothing. Patrick: See Bug 440238.

Trace (5.7) is done with SWTBot
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6.1
6.2

6.3
6.4
6.5

6.6
6.7
6.8
6.9

7.1
7.2

7.3

8.1

8.2

83

8.4

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name

Error empty Connection node
name

Duplicate Connection node name
Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile

Export Profile
Import Profile

Import Profile

Remote Fetch Wizard

Preparation

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory), only 1 trace
selected

Clear traces

Run Profile "TestAllRecursive"

3.0.0-TraceCompassTestCases - TMF - Remote Fetching

Clear profile name
Add profile with name of existing profile

Clear Connection node name
Within a profile, add Connection node with name of existing node
remove user name of a Connection Node

add invalid URI

Delete Trace Group root path

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button > Select Folder and
enter file name > OK

Click on Import Button > select profile XML file > OK

Redo 7.2

1) Import Test Profiles (test-profiles.xml) from test spec. template
directory

2) Edit profiles in Fetch Remote Traces > Manage profiles

3) Change 'user' and '127.0.0.1' for all connection nodes if necessary
3) Extract traces.zip from test spec. template directory in /tmp

4) Load custom text parsers located in traces.zip
(traces/customParsers)

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in this group
3) Select profile in Fetch Remote Traces wizard (Remote Profile
page)

4) Click on "Next' button

5) Click on 'Finish'

Delete all traces from Traces directory

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmpl/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in this group
3) Select profile in Fetch Remote Traces wizard (Remote Profile
page)

4) Click on 'Next' button

5) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Error message "Profile must not be empty"
Error message "<name>: Duplicate profile name"

Error message "Node name must not be empty"
Error message "Duplicate node names"
Error message "URI must include user information"

Error message "URI must include valid host and port number" or
"Unsupported URI scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be empty"
Error message "Invalid file pattern"

Only selected profiles are exported
Profiles are imported

after second import an error message appears "Duplicate profile
names"

Verify that all test traces are imported with correct trace types
assigned. Verify that folder structure is preserved.

All traces deleted

Verify that only the selected traces are imported with correct trace
types assigned. Verify that folder structure is preserved.

All traces deleted

Verify that all test traces are imported with correct trace types
assigned (LTTng kernel, LTTng UST, custom text, custom XML).
The file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Manual
Manual

Manual
Manual
Manual

Manual
Manual
Manual
Manual

SWTBot
SWTBot

Manual

SWTBot

SWTBot

Manual

Local connection is used in SWTBot

Local connection is used in SWTBot
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8.5

8.6

8.7

8.8

8.9

8.10

8.12

8.13

Re-run Profile "TestAllRecursive"
(Rename)

Re-run Profile "TestAllRecursive
(Overwrite)

Re-run Profile "TestAllRecursive"
(Skip)

Re-run Profile "TestAllRecursive"
(Overwrite 2)

Clear traces

Re-run Profile "TestAllRecursive"
(2

Clear traces

Run Profile
"TestAllNonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces

Run Profile
"TestSpecificMutliGroupRecursiv
o

Clear traces

3.0.0-TraceCompassTestCases - TMF - Remote Fetching

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Rename’ for the first trace and 'Rename ALL'
for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Overwrite' for the first trace and 'Overwrite
ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Skip' for the first trace and *Skip ALL' for the
second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Select checkbox 'Overwrite traces without warning'

3) Click on 'Next' button (enter password if needed)

4) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)
2) Click on 'Finish' (enter password if needed)

Delete all traces from Traces directory

1) Select profile "TestAllNonRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in Fetch Remote Traces

wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

Verify that all test traces are imported with new name and correct
trace types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory structure is
preserved.

Verify that all test traces are imported with correct trace types
assigned where old traces are overwritten. (LTTng kernel, LTTng
UST, custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that directory
structure is preserved.

Verify that all test traces are skipped and no trace is imported

Verify that all test traces are imported with correct trace types
assigned where old traces are overwritten (no dialog box opens).
(LTTng kernel, LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace type. Make
sure that directory structure is preserved.

All traces deleted

Verify that all test traces are imported with correct trace types
assigned. The second page is omitted. (LTTng kernel, LTTng
UST, custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that only traces from root path are imported (LTTng kernel,
LTTng UST, custom text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type. Make sure that
directory structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs are imported
from root and subdirectory. Make sure that directory structure is
preserved.

All traces deleted

Verify that only kernel and custom text/XML logs are imported
from root directory only. Make sure that directory structure is
preserved.

All traces deleted

Verify that only traces from root path are imported (LTTng kernel,
LTTng UST, custom text, custom XML). Make sure that directory
structure is preserved.

All traces deleted

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Profile has trace type 'Generic CTF Trace' but

trace imported as 'Linux Kernel Trace'. Patrick:

Looks intentional, see
RemoteGenerateManifestOperation:186.

Profile has trace type 'Generic CTF Trace' but

trace imported as ‘Linux Kernel Trace'. Patrick:

Looks intentional, see
RemoteGenerateManifestOperation:186.

Profile has trace type 'Generic CTF Trace' but

trace imported as 'Linux Kernel Trace'. Patrick:

Looks intentional, see
RemoteGenerateManifestOperation:186.
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8.14

8.15

9.1

9.2

10

10.2

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

Connection Handling
Error cannot connect to remote
host (node doesn't exist)

Error cannot connect to remote
host (wrong password)

Other Remote Backends
Clear traces

Remote Fetch using Local

3.0.0-TraceCompassTestCases - TMF - Remote Fetching

1) Select profile "TestAllRecursive" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) Cancel import (red square or Cancel button)

Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch Remote Traces wizard
(Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Create profile with IP address that cannot be connected to and run
profile

Create profile valid IP address. When asked for password enter
invalid password

Delete all traces from Traces directory

Create profile (see 7.3) with URI scheme file (instead of ssh) and
node name Local and redo test 7.3

Verify that import operation is cancelled
All traces deleted

Verify that only traces from root path are imported (LTTng kernel,
LTTng UST, custom text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type. Make sure that
directory structure is preserved. 2 nodes directories are created with
the above traces stored

Operation to connect to remote node fails and error dialog is shown
with detailed information (after time-out)

Operation to connect to remote node fails with time-out and error
dialog is shown with detailed information. Note time-out is as per
remote development preferences

All traces deleted

Verify that all test traces are imported with correct trace types
assigned (LTTng kernel, LTTng UST, custom text, custom XML).
The file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Manual

Manual

Manual

Manual

SWTBot

Bruno : Not really a bug, but you have to fail your
password 5 times before having the first error
dialog poput. Only then you see the Internal error

This is the Remote Systems implementation with
retries.

See tests 7.2/7.3

Cannot connect <node name>, message. Patrick:
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Section
LTTng 2.0 - Control Flow View

Target: Windows

Step

0

0.1

-

1.1

1.2

1.2
1.3

1.4

2.3

3.1

Test Case

Prerequisites
Import traces
Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph

Mouse handling

Drag move chart area

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

3.0.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and

remain aligned. Selected process does not
change. Vertical scroll bar updated.

Type To Do
14 0
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
10

Comment

What is called 'time range' here should actually be called
‘'window span'.
Documentation fix : what does "states are updated" imply?

Documentation fix : what does "states are updated" imply?

| Documentation fix : what does "states are updated" imply?
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3.5

3.6

3.7

3.8

3.9

3.1

41

4.2

5.1

52

53

54

5.5
5.6

Vertical scroll bar

Drag zoom time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection

Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph

(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

3.0.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, stop time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

_negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

SWTBot

Manual

SWTBot

Manual

Manual
SWTBot

Documentation fix : what does "states are updated" imply?

Documentation fix : what does "states are updated" imply?

Documentation fix : what does "states are updated" imply?

Documentation fix : what does "states are updated" imply?

Pro tip: "Uncheck selected" and "Uncheck subtree" do the same thing
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5.7

5.8

5.9

5.10

5.11

5.12

5.13

5.14

6.1

6.2

6.3

6.4

7.1

7.2

Filter Processes

Hide Arrows

Follow CPU Forward

Follow CPU Backward

Optimize

Re-Optimize

Go to next event of selected thread

Go to previous event of selected
thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range (no
overlap)

3.0.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

With focus on time graph, click Follow CPU
Backward button

Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to next event
of selected thread

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing

3) Import UST ${local}
[traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

Select a time and new range

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.

verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event

Verify in the events table that the selected
thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

View shows the last opened trace

Selected time line and time range is updated to
selected time and new range.

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Tested with Ressources view, Control Flow view and Histogram view.
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3.0.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are restored to the
Select other trace (no overlap) tab selected trace's previously selected time and range. Manual
Open multiple traces (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and range
(overlap) Select a time and new range

Selected time line and time range is updated to
selected time and new range. Manual

View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are set to the newly

7.6 Select other trace (overlap) tab selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 | Filtering |
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
Persitent filter Switch between both open traces available Manual
‘Miscellaneous
1) Open LTTng Kernel Trace
2) Select Control Flow View
Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated Manual

1) Open LTTng UST trace while CFV is open Verify that current window range stays doesn't
Select single time (Bug 477009) 2) Select event in events table change Manual

1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
'range 1".
2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.
3) Go "left one page" on Resources view by
Window range synchronization pressing left arrow in scroll bar. Verify that after each step the initial window
(Bug 477012) 4) Go "right one page" on Control Flow view. range doesn't change Manual




Step
0
0.1

0.2

-

1.1

1.2
1.3

2.2

2.3

3.1

3.2

3.3

34

Section

LTTng 2.0 - Resources View
Target: Windows 7

Test Case
Prerequisites
Import traces
Create experiment
View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

Drag move canvas

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

3.0.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective, and
select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down on
header or Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Verification

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

To Do

SWTBot

SWTBot

Manual
SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment
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3.5

3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

5.2

5.3

5.4

55

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection

Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph

(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

3.0.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Process button

Click Zoom In/Out button

Time graph scroll up and down and remain
aligned. Selected process does not change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows hover time, tid and process
name.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

_negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

When not zoomed enough, tool tip does not show CPU for
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state.

Pass if Next Process refers to Next Resource, else buttons
don't exist
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5.6 Filter Dialog ~ Open Filter Dialog Verify that all buttons are working correctly Manual
6 Synchronization
Selected time line is updated. If selected time
is outside current range, time range is
6.1 Time synchronization Select a random time in another view updated to include it. Manual
Select a new time range in Control Flow view
6.2 Time range synchronization or in Histogram view. Time range is updated. Manual
Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current
6.3 ‘synchronisation ‘synchronization, select a new range. ‘range, then time range is updated to include it | Manual
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
/traces/import/kernel-overlap-testing
3) Import UST ${local}
/traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it
Preparation
7.1 Open multiple traces (no overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and range (no Selected time line and time range is updated to
7.2 overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are restored to the
7.3 Select other trace (no overlap) tab selected trace's previously selected time and range. Manual
7.4 Open multiple traces (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated to
7.5 (overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are set to the newly
7.6 Select other trace (overlap) tab selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 | Filtering |
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persistent filter Switch between both open traces available Manual

Status bar of Eclipse is updated only for timegraph views
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9.1

Restart (Bug 409345)

3.0.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

1) Open LTTng Kernel Trace
2) Select Resource View
3) Restart Eclipse

Verify that Resources View is populated Manual
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Target:

Step

0

0.1

21

22

31

32

3.3

3.4

35

3.6

3.7

3.8

Section
LTTng 2.0 - Control
View

Ubuntu 14.04 64 bit
LTTng Tools 2.9.4, Built-in
SSH

est Case Action
Prerequisites

For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.5.x or later) is required. Make sure that the
root session daemon is running (sudo Iting list -k) and have one
UST process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

a) Window — Preferences — General — Network Connections

Set Proxy b) Set “Active Provider” to “Direct”
General
Open perspective Open and reset LTTng Kernel Perspective
Manage View
Close view Close Control View
Use menu Window — Show View — Other ... — Lttng —
Open Control view Control

Connection Handling

1) Click Button 'New Connection..."
2) Select Tree item "Built-in SSH" and click on Create
3) Enter Connection Name (e.g. MyHost), enter Host Name (a
DNS name or IP address), username and password
4) Click 'Finish'
Create Host Connection 5) In Tree select the newly create connection and click on 'Ok’
a) Select host to disconnect and click Button 'Disconnect’
Disconnect b) Redo test with context sensitive menu item 'Di:

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

LTTng Tracer Control User Gui http: clipse.org/Li

LTTng Kernel perspective opens with correct Control view
on the left bottom corner

Control view is removed from perspective

Verify that Control view is shown

Make sure that after 4) the new connection is shown in
the tree. Verify that the new host is shown in the Control
view (with 'Connection Name'. After Ssh connection has
been established, make sure that Provider and Session
nodes are created in the Control view underneath the
host. Verify that all active Providers (Kernel and UST
providers) are shown under the 'Provider' node.

Verify that icon for the corresponding node changes to
the di icon and all sub-nodes are removed.

a) Select host to connect and click Button ‘Connect'
Connect b) Redo test with context sensitive menu item 'Connect'

1) Restart Eclipse

2) Click Button 'New Connection..."

3) Select the host previously created

4) Select 'Ok'. (Afterwards enter user ID and Password if
Select Host Connection necessary)

Node contexts sensitive 1) Connect to remote host
menu (host connected)  2) select connected node and click right mouse button

View button enable state 1) Connect to remote host (if necessary)
(host connected) 2) select connected node

Node contexts sensitive
menu (host 1) Disconnect from node
disconnected) 2) select disconnnected node and click right mouse button

View button enable state 1) Disconnect to remote host (if necessary)
(host connected) 2) select disconnected node if necessary

Verify that icon for the corresponding node changes to
the icon and after SSH

all data is retrieved form the remote host (Providers,
sessions etc).

Make sure that SSH connection is established and all
data is retrieved from the remote host ( (Providers,
sessions etc).

Verify that menu items are shown and enabled/disabled
depending on state:

‘Connect’ (disabled)

Disconnect (enabled)

Refresh (enabled)

Delete (disabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect' (disabled)
‘Disconnect’ (enabled)
‘Refresh’ (enabled)

‘Delete’ (disabled)

‘Start' (disabled)

‘Stop’ (disabled)

‘Destroy Session..." (disabled)
‘Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that menu items are shown and enabled/disabled
depending on state:

‘Connect' (enabled)

‘Disconnect’ (disabled)

‘Refresh’ (disabled)

‘Delete’ (enabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect' (enabled)
‘Disconnect’ (disabled)
"Refresh’ (disabled)

'Delete’ (enabled)

‘Start' (disabled)

'Stop' (disabled)

‘Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Type  ToDo Comment

Type Comment

Manual

SWTBot

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual
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4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

4.11

Delete
Create Host Connection
with ssh port

Session Handling
Preparation

Sessions Context
Sensitive Menu

Create Session (default
location)

Create Session (custom
location)

Create Session —
session already exists in
GUI

Create Session —
session already exists
on node

Session Context
Sensitive menu (session
inactive)

View button enable state
(session inactive)

Start Session

Session Context
Sensitive menu (session
active)

View button enable state
(session active)

Destroy Session

Kernel Channel

a) Select node to delete (state disconnected) and click on
button 'Delete’
b) Redo test with context sensitive menu item 'Delete’

re-do 3.1 but this time specify a port number other than default
SSH port 22

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on ‘Sessions’

2) Select 'Create Sessiol in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty
4) Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MyOtherSession'

4) enter custom path (/tmp/myTraces) for 'Session Path'
5) Select 'Ok’

1) Click right mouse button on 'Sessions'
2) Select 'Create Sessiol in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path' empty

1) login to the remote host using a command shell

2) type Ittng create newSession and press enter. This will create
a session which is not know by the Control view.

3) Click right mouse button on 'Sessions"

4) Select 'Create Session..." in the context sensitive menu

5) Enter session name 'newSession', keep 'Session Path' empty
6) Select 'Ok’

Select newly created session and click right mouse button

Select newly created session (enable an event before)
a) Enable an event

b) Select session and click on button 'Start'

c) Redo test with context sensitive menu item 'Start'

Select started session and click right mouse button

Select started session

1) In the Control view select session 'MyOtherSession'

2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu
4) Select 'Ok’ in the confirmation dialog box

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that host is removed from the control view. Manual
The connection should fail (unless remote is configured
for the specified port) Manual

Verify that menu items are shown and enabled: 'Refresh’,
‘Create Session...", Load..." and 'Execute Command Script
. Manual

Verify that new session is added under the Session tree

node. Verify properties in Properties view (by selecting

the session in the Control view):

'Session name' (=MySession)

‘Session Path' (=/home/<user>/traces/MySession_<date

and time>) and 'State’ (=INACTIVE) SWTBot

Verify that new session is added under the Session tree

node. Verify properties in Properties view (by selecting

the session in the Control view):

'Session name' (=MyOtherSession)

'Session Path' (=/tmp/myTraces) and 'State’

(=INACTIVE) Manual

Make sure that an error message appears in the
message area of the dialog box with information that
session 'MySession' already exists in the tree. Manual

Verify that an error dialog box will show with information

that command to create a session failed. session already

exists on the node. Select 'Details": Verify that the

command error detail is shown (with return value (28)) Manual
Verify context sensitive menu items:

‘Refresh’ (enabled)

‘Start' (enabled)

'Stop' (disabled)

‘Destroy Session..." (enabled)

‘Import..." (enabled)

‘Save..." (enabled)

‘Enable Channel..." (enabled)

‘Enable Event (default channel)...' (enabled)

'Record Snapshot' (disabled) Manual

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect' (disabled)

‘Disconnect’ (disabled)

‘Refresh’ (enabled)

‘Delete’ (disabled)

'Start' (enabled)

'Stop' (disabled)

‘Destroy Session..." (enabled)
‘Import..." (enabled)

'Record Snapshot' (disabled) Manual

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state SWTBot

Verify context sensitive menu items:

‘Refresh’ (enabled)

'Start’ (disabled)

‘Stop' (enabled)

'Destroy Session..." (disabled)

‘Import..." (disabled)

'Enable Channel..."' (disabled)

‘Enable Event (default channel)..." (disabled) Manual

Verify enable state of view buttons:

‘New Connection..." (enabled)

‘Connect' (disabled)

'Disconnect’ (disabled)

‘Refresh’ (enabled)

‘Delete’ (disabled)

'Start' (disabled)

'Stop' (enabled)

‘Destroy Session..." (disabled)

‘Import..." (disabled) Manual

Verify that session is removed from the control view. SWTBot
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5.1

52

53

5.4

55

5.6

58

6.1

71

72

73

74

75

76

77

Preparation

Enable Channel on
session level (default
values)

Enable Channel on
domain level (changed
values)

Enable Channel —
channel already exists

Domain Context
Sensitive menu

Channel Context
Sensitive menu

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on
session level (default
values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (syscalls)

Enable Event on
Channel level (Dynamic
Probe)

Enable Event on
Channel level (Dynamic
Function Probe)

Disable Event

Enable Event (tracepoint
events)

Enable Event (probe
events)

1) Connect to remote host
2) Create new Session 'MyOtherSession'

1) Select session and right mouse click
2) Select menu item 'Enable Channel
3) Enter Channel name (e.g. myChannel) and keep default
values

4) Select Kernel

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel..."

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

1) Select channel '"MyChannel' and click right mouse button
2) Select 'Disable’ menu item

1) Select channel 'MyChannel' and click right mouse button 2)

Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel..."
3) Enter Channel name ‘MyChannel'

4) Select UST

5) Click on Button 'Default’

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)..."
3) Select 'Kemnel"

4) Select Radio button for "Tracepoint Events'

5) Select top level tree node 'All"

6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button

2) Select menu item 'Enable Events..."
3) Select Radio button for 'Dynamic Probe’

4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,
see file /boot/System.map<kernel version>, valid symbols have

T or t as type, | used 'backtrace_stack' for example)
5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button

2) Select menu item 'Enable Events..."
3) Select Radio button for 'Dynamic Function Entry/Return
Probe’
4) Enter Event Name 'MyOtherEvent' and Probe (e.g.
r

create_dev, see file /p or
version>)
5) Click on Ok

1) Select multiple events (tracepoint events) under a channel
(not syscalls) and click right mouse button
2) Select 'Disable’ menu item

1) Select multiple disabled events and click right mouse button

2) Select 'Enable’ menu item

1) Select a probe event (function or dynamic probe) disabled
events and click right mouse button
2) Select 'Enable’' menu item

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that domain 'Kernel' is created under session and
channel is added under the domain. Verify that default
values for the channel are displayed in the Properties
view after selecting the channel in the tree.

Verify that channel is added under the domain. Verify that
correct values for the channel are displayed in the
Properties view after selecting the channel in the tree.

Verify that error dialog box is opened notifying that
channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled)

‘Enable Channel...' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

Verify context sensitive menu items:
‘Refresh’ (enabled)

'Enable Channel' (disabled)

‘Disable Channel' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menu
item 'Disable’ is disabled and menu item 'Enable’ is
enabled

Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Properties view, menu
item 'Disable’ is enabled and menu item 'Enable’ is
disabled

Verify that domain 'UST global' is created under session
and channel is added under the domain. Verify that
default values for the channel are displayed in the
Properties view after selecting the channel in the tree.
See 5.7/5.8

Verify that default channel (channel0) is create under
domain 'Kernel' and that all tracepoint events are added
under the channel with state ENABLED. Verify properties
view show correct values when selecting a event in the
tree (Event Type=TRACEPOINT, State=ENABLED)

Verify that event with name syscalls is added under the
default channel (channel0) with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=SYSCALL,
State=ENABLED)

Verify that event with name 'MyEvent' is added under the
respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=Probe, State=ENABLED,
Address=0xc0101280, Event Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when selecting
a event in the tree (Event Type=Function,
State=ENABLED, Symbol=create_dev, Offset=0x0, Event
Name=MyOtherEvent)

Verify that all selected events are disabled (disabled
event icon is shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is disabled and
menu item 'Enable’ is enabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable' is enabled and menu item
‘Enable’ is disabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item ‘Disable’ is enabled and menu item
'Enable’ is disabled

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot
Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Command to change state of events failed

Command failed! Command: Ittng —-mi xml enable-event MyEvent -k -s auto-20160607-005527 -c sdf -probe Oxfftf820a25f5
Error Output:

Error: Event MyEvent: Enable kernel event failed (channel sdf, session auto-20160607-005527)

Return Value: 43

<2xm version:

" encoding="UTF-8"?>

<command xmin: i" xmins:xsi="http: 3. hema-inst

Command to change state of events failed
Command failed! Command: Ittng —mi xml enable-event bob -k -s MyOtherSession ~function create_dev
Error Ouptut:

Error: Event bob: Non-default channel exists within session: channel name needs to be specified with '-c name’ (channel <default>, session MyOtherSession)

Return Value: 83
<7xml version="1.0" encoding="UTF-8"?>

P! pe>FUNCTION</typ
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7.8

8.1

8.2

83

8.4

85

8.6

8.7

8.8

9.2

9.3

Enable Tracepoint Event
using filter in tree (Bug
)

UST Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (wildcards)

Enable Event on
Channel level (log level)

Enable Event on
Channel level (log level
oly)

Enable/Disable Event
(tracepoint events)
Enable/Disable Event
(tracepoint events)

Enable Tracepoint Event
using filter in tree (Bug
450526)

Enable Event by name

Contexts Handling

Add Context (to
channel)

Add Context (to
channel)

Add Context (to event)

Enable Events (from
Provider)

Enable Kernel Events

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter a filter (e.g. sched) for the tracepoint tree and then
select Al

4) Click on Ok

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...
3) Select 'UST'

4) Select Radio button for "Tracepoint Events'

5) Select top level tree node "All'

6) Click on Ok

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)..."
3) Select Radio button for 'Wildcard"

4) Enter a wildcard (e.g. ust*)

5) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for ‘Log Level'

4) Enter Event Name 'MyEvent'

5) Select log level TRACE_ERR

6) Select radio button for loglevel

7) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Log Level'

4) Enter Event Name 'MyOtherEvent'

5) Select log level TRACE_INFO

6) Select radio button for loglevel-olny

7) Click on Ok

Redo tests 7.5 and 7.6 with UST tracepoint events

Redo tests 7.5 and 7.6 with UST (loglevel/loglevel-only) events
1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter filter for the tracepoint tree and then select All

4) Click on Ok

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Select Tracepoints

4) Enter list of names (comma-separated) in text box

5) Click on Ok

1) Select kernel channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname,

pid)
4) Click on 'Ok’

1) Select UST channel and click right mouse button

2) Select menu item 'Add Contexts..."

3) Expand tree and select contexts procname, pthread_id, vpid
and vtid

4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse button

2) Select menu item 'Add Contexts..."

3) Expand tree and select some contexts (e.g prio, procname,
id,

pi
4) Click on 'Ok’

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or
later this menu item has to be disabled

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —
Kernel

3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly created session

6) Select 'Ok’

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that only the selected tracepoints (filtered) are
enabled and not all kernel tracepoionts Manual

Verify that default channel (channel0) is create under

domain 'UST global' and that a wildcard event “*” is

create under the channel with state ENABLED. Verify

properties view show correct values when selecting a

event in the tree (Event Type=TRACEPOINT,

State=ENABLED) Manual

Verify that event with wildcarded name (e.g ust*) is added

under the default channel (channel0) with state

ENABLED. Verify properties view show correct values

when selecting a event in the tree (Event

Type=TRACEPOINT, State=ENABLED) Manual

Verify that event with name ‘MyEvent' is added under the

respective channel with state ENABLED. Verify properties

view show correct values when selecting a event in the

tree (Event Type=TRACEPOINT, State=ENABLED, Log
Level=<=TRACE_ERR, Event Name=MyEvent) SWTBot

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Leve RACE_INFO, Event
Name=MyOtherEvent).

Manual
See 7.5/7.6 Manual
See 7.5/7.6 Manual

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts Manual

Verify that events entered in the comma-separated list are added to
SWTBot

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information. Manual

Verify that command is successful (no error).

NOTE 1: There is no way to retrieve added contexts from

the trace. Therefore GUI cannot display this information.

NOTE2: For UST only contexts procname, pthread_id,

vpid and vtid are supported Manual

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information. SWTBot

Verify that domain ‘'Kernel' is created under the new

session. Verify that default channel ‘channel0' is created

under the domain. Verify that selected events are added

under the channel and are ENABLED. Manual

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties
view now

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties
view now

DEPRECATED
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10.2

"

111

11.2

14

14.1

142

Enable UST Events

Importing to Project

Preparation

Import to project

Import to project
(Override)

Import to project
(Overwrite All)

Import to project
(Rename)

Import to project
(Rename All)

Import to project (Skip)
Import to project (Skip
All)

Refresh

Refresh

Event Filtering (LTTng
2.1)

Preparation

1) Make sure that UST application is running on remote host
(see step 0)

2) Create a new session

3) Create a channel under domain 'UST global"

4) Select multiple UST Tracepoint events under Providers ->
<UST Process>

5) click right mouse button

6) select menu item 'Enable Event..."

7) Select newly created session

8) Select newly created channel

9) Select 'Ok

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
7) Create new Tracing Project

1) Select session from 11.1 and click right mouse button
2) Select 'Import..."
3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Overwrite' (kernel trace)

3) In dialog box select ‘Overwrite' (UST trace, re-do if more
than 1 UST trace)

1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Overwrite All'

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Rename' (kernel trace)

3) In dialog box select 'Rename’ (UST trace, re-do if more than
1 UST trace)

1) Repeat step 1 - 3 of test case 11.2

2) In dialog box select 'Rename All'

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Skip' (kernel trace)

3) In dialog box select 'Skip' (UST trace, re-do if more than 1
UST trace)

1) Repeat step 1 - 3 of test case 11.2

2) In dialog box select 'Skip Al

Press refresh button and context sensitive menu item for
different selections

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from lttng-tools git repository under
tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession’

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that selected events are added under the selected
channel and are ENABLED.

After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote" is
selected.

Verify that during import a progress dialog is opened to
show the progress of the import operation.

Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel Trace" is set and for
the UST traces the trace type "LTTng UST Trace" is set.
Create Experiment, select all traces and open

Experiment. Make sure that all view are populated
correctly in the LTTng Kernel Perspective.

Verify that traces are imported and existing traces are
overwritten

Confirmation dialog only shows once. Verify that traces
are imported and existing traces are overwritten

Verify that traces are imported with a different name

Confirmation dialog only shows once. Verify that all traces
are imported with a different name:

Verify that each skipped trace is not imported

Confirmation dialog only shows once. Verify that all traces
are skipped

Verify that the Control View is refreshed.

Manual

Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual - Should have an accelerator like 5
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3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that default channel (channel0) is create under

1) Select session and click right mouse button domain 'UST global' and that the corresponding event is
2) Select menu item 'Enable Events (default channel)..." created under the channel with state ENABLED.
3) Select 'UST"
4) Select Radio button for "Tracepoint Events' Verify that Properties view shows correct values for this
5) Select one tracepoint event (Event Type=TRACEPOINT, State=ENABLED,
Enable UST Event on 6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.8
143 session level 7) Click on 'Ok’ +) Manual
1) Execute 14.3
2) Select one UST Tracepoint event under Providers -> <UST  Verify that selected event is added under the selected
Process> channel.
3) click right mouse button
4) select menu item 'Enable Event..." Verify that Properties view shows correct values for this
5) Select newly create session and channel event (Event Type=TRACEPOINT, State=ENABLED,
Enable UST Event from  6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.8
14.4 provider 7) Click on 'Ok’ +) Manual
1) Start Tracing
2) Stop Tracing after a view seconds
3) Import Trace to Project
4) Open Trace Make sure that only events are shown in the events table
145  Create trace 5) Destroy Session that met the condition in the filter expressions Manual
Create Session With
Advanced Options
15 LTTng v2.1)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
15.1 tests/hello.cxx)
After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)
1) Open Create Session Dialog box After 3) verify that advanced option are not shown and
Create Session Dialog - 2) Select "Advanced >>>" only basic options are there (Session Name and Session
152 Advanced Button 3) Select "<<< Basic" Path) Manual
After 2) verify that data Protocol and data Address is
enabled. Note that the ports cannot be configured for net
1) Open Create Session Dialog box and select "Advanced >>>" and net6 when this button is unchecked. -> port text fields
Create Session Dialog - 2) Uncheck checkbox"Use same protocol and address for data  are disabled
Check box "Use same  and control"
protocol and address for 3) Check checkbox "Use same protocol and address for data After 3) Verify that data Protocol and data Address are
15.3  data and control and control” disabled Manual
1) Open Create Session Dialog box and select "Advanced >>>"
Create Session Dialog - Verify that the Control protocol dropdown menu shows
154 Protocol list net, net6 and file Manual
1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
Create Session Dialog - and control" After 2) verify that the data protocol dropdown menu
155 Protocol list 2 shows net, net6, tcp and tcp6 Manual
After 2) verify that net6 is propagated to the data protocol
and and that the data and control port text fields are
1) Open Create Session Dialog box, select "Advanced >>>" enabled
Create Session Dialog - 2) Select net6 for Control Protocol After 3) verify that file is propagated to the data protocol
15.6 Protocol propagation 3) Select file for Control Protocol and that the data and control port text fields are disabled. ~ Manual
Create Session Dialog - 1) Open Create Session Dialog box, select "Advanced >>>" After 2) verify that the IP address is propagated to the
15.7 Address propagation 2) Enter IP address in Control address data address field Manual
1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
and control”
3) Select tcp for control protocol and tcp6 for data protocol
4) Check checkbox "Use same protocol and address for data
Create Session Dialog - and control" After 4) make sure that both data and control protocol
15.8  Protocol propagation 2 show net Manual

Verify that the traces are stored on the remote host under
Itmp/testTraces/kernel and
ItmpltestTraces/ust/<application(s)> repectively.

1) Open Create Session Dialog box and select "Advanced >>>"

2) Enter session name, select file protocol and enter directory ~ After 2) make sure that the Session Path in the Property

Itmp/testTraces/ in address field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4

Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.9 protocol 5) Destroy session transfer the traces to the tracing project. Manual



15.10

15.11

16.12

15.13

15.14

16.1
16.2
16.3

16.4

16.7

16.8

Create trace with file
protocol and trace path

Create trace with net
protocol

Create trace with tcp
protocol and port

Live Streaming Session
(UST) - Initial
implementation

Live Streaming Session
(Kernel) - Inititial
Implementation

Preferences

Open Preference Dialog
Enable Logging
Disable Logging

Test Logging level none

Test Verbose Logging
(Level 1)

Test Verbose Logging
(Level 2)

Test Verbose Logging
(Level 3)

Append Mode

1) Open Create Session Dialog box and select "Advanced >>>"
2) Enter session name, select file protocol and enter directory
Itmp/tmpTraces/ in address field, enter /newPath in "Trace
Path" text field and press ok

3) Enable events, start tracing, wait for a few seconds, stop
tracing

4) Import traces to a existing tracing project

5) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd;

2) Open Create Session Dialog box and select "Advanced >>>"
3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok

4) Enable events, start tracing, wait for a few seconds, stop
tracing

5) Import traces to a existing tracing project

6) Destroy session

1) Uncheck checkbox "Use same protocol and address for data
and control"

2 ) Start relayd on Eclipse local machine with specified ports
(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp://0.0.
3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select tcp protocol and enter IP address
of Eclipse local machine in address field, specify data and
control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok

5) Enable UST events (per UID channel), start tracing, wait for a
few seconds, stop tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok

5) Enable Kernel events, start tracing, wait for a few seconds,
stop tracing

6) Import traces to a existing tracing project

7) Destroy session

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Tracer Control Preferences)

In Tracer Control Prferences, check checkbox Logging

In Tracer Control Prferences, uncheck checkbox Logging
Execute 16.2 and execute some commands (e.g. create
session, enable event)

1) Execute 16.2
2) select verbose level Level 1
3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 2
3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 3
3) Execute some commands (e.g. create session, enable event)

Check checkbox Append, restart Eclipse and open Tracer
Control Preferences

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that the traces are stored on the remote host under
ItmpltestTraces/newPath/kernel and
ItmpltestT

After 3) make sure that the Session Path in the Property
View shows the URL with the configured parameters

Verify that the remote import dialog box opens at step 4
(as described in test cases 11.x) and it is possible to
transfer the traces to the tracing project.

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/lttng-traces/<remote
machine name>/<session name + date>/kernel and
machine

g
name +

repectively.

After 3) make sure that the Session Path in the Property
View shows the URL with the configured parameters

After 5) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens. Then
verify that it is possible to transfer the traces to the tracing
project.

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/lttng-traces/<remote
machine name>/<session name + date>/kernel and
machine

9
name + d

repectively.

After 4) make sure that the Session Path in the Property
View shows the URL with the configured parameters

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens. Then
verify that it is possible to transfer the traces to the tracing
project.

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

Verify that tracer control preferences exists and shows
Tracing Group, Logging, Log File (always disabled),
Append, Verbose Level (None, Level 1, Level2 Level 3)
Verbose Level radio buttons will be enabled

Verbose Level radio buttons will be disabled

Make sure that log file is created and contains the
executed commands and command replies

Make sure that log file contains the executed commands
with -v option (e.g. Ittng -v create session) and the
command replies come with debug information

Make sure that log file contains the executed commands
with -vv option (e.g. Ittng -vv create session) and the
command replies come with debug information

Make sure that log file contains the executed commands
with -vvv option (e.g. Ittng -vvv create session) and the
command replies come with debug information

Verify that tracer control preferences are persisted and
the log file is opened in append mode (old file is not
overwritten)

Manual

Manual

Manual

SWTBot

SWTBot

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

Implementation disabled for 2.0

Implementation disabled for 2.0

This makes no difference for MI starting with Lttng 2.6

This makes no difference for MI starting with Lttng 2.6

This makes no difference for MI starting with Lttng 2.6
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3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that Ittng command is executed with command line
Change Tracing group (e.g. tracing2) and execute a command  option -g <group>. Ignore any command reply errors (if

169  Change Tracing Group  (while logging enabled) any) Manual
Change execution After verify that values smaller than 5 and bigger than 600
16.10  timeout Go to Remote Connection Preferences, Change Timeout are rejected Manual

Verify: Group=tracing, Logging is deselected, Append is
deselected, Verbose Level=None), and Command Timout
16.11  Reset Reset to defaults is 15 Manual

Create Channel with
advance features
17 (LTTng 2.2 features)

For the tests below a Ubuntu machine with LTTng 2.2 installed
(with Ittng tools 2.2.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under

171 tests/hello.cxx).
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..." Verify after 3) that ‘Channel Name' is set to metadata and
3) Select Checkbox 'Configure metadata channel' the correspondig textbox is disabled. Verify after 5) that
4) Update all text boxes metadata channel was created under the kernel domain.
Configure Metadata 5) Click on 'Ok’ Also verify in the properties view that all parameters are
17.2 channel (kernel) set correctly when selecting the channel metadata. Manual

Verify after 3) that 'Channel Name' is set to metadata and
the correspondig textbox is disabled. Verify after 5) that
metadata channel was created under the domain UST

global. Also verify in the properties view that all Command is successful. However tracer doesn't create
Configure Metadata parameters are set correctly when selecting the channel metadata channel. Bug in LTTng http:/bugs.Ittng.
17.3 channel (UST) 1) Re-do 17.2 with a UST channel metadata. Manual orglissues/994
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel
3) Fill in channel name
4) Fill in 1048576 in '‘Maximum size of trace files' and also 'Sub
Buffer Size'
5) Fill in 2 in "Maximum number of trace files'
6) Click on 'Ok’
Configure File rotation  7) Enable all kernel events After 8) verify on the trace node that trace files are not
174 (kernel) 8) Start, wait and stop tracing. bigger than 1048576 bytes Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel
3) Fill in channel name
4) Select UST
5) Fill in 262144 in "Maximum size of trace files' and also 'Sub
Buffer Size'
6) Fill in 2 in "Maximum number of trace filesfiles'
7) Click on 'Ok’
Configure File rotation ~ 8) Enable all UST events After 9) verify on the trace node that trace files are not
17.5 (ust) 9) Start, wait and stop tracing. bigger than 262144 bytes Manual
1) Create and select session and click right mouse button Verify after 2 and 4 that the radio buttons for the buffer
2) Select menu item 'Enable Channel..." type is disabled and the buffer type "Global shared
3) Select UST buffers" is selected which is the value for the kernel
4) Select Kernel tracer.
Buffer Type - toggle 5) Slect cancel Verify after 3) that the radio buttons are enabled an no
17.6 UST/kernel buffer type is selected Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."
3) Select UST Verify after 5) that the default buffer type is configured for
4) Enter Channel Name that channel (see properties view). Note for LTTng Tools
5) Select 'Ok’ 2.2 the default is per-PID and for LTTng Tools 2.3 and
17.7  Default UST Buffer Type later it is per-UID Manual
Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."
3) Select UST
4) Select 'Per PID buffers'
5) Enter Channel Name
6) Select 'Ok
8) Enable all ust events Verify after 6) that the per-pid buffer type is configured for
per PID UST Buffer 9) Start, wait and stop tracing. that channel (see properties view). After 10) make sure
17.8  Type 10) Import trace that for each UST application one trace is created Manual
Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel
3) Select UST
4) Select 'Per UID buffers'
5) Enter Channel Name
6) Select 'Ok’ Verify after 6) that the per-pid buffer type is configured for
8) Enable all ust events that channel (see properties view). After 10) make sure .
per UID UST Buffer  9) Start, wait and stop tracing. that only one trace is created even multiple UST PO A A I A Pl
17.9 Type 10) Import trace applications are running. Manual I/bugs.eclips /_bug.ce

Snapshot Channel
18 (LTTng 2.3 features)

Preparation Connect to a node with LTTng 2.3 installed



18.1
18.2

18.3

184

18.5
18.6
18.7

18.10

18.11

18.12

20

20.1

20.3

Create Snapshot
Session

Enable Kernel Event

Start Session

Record snapshot

Create another snapshot

session
Enable UST Events
Start UST session

Record snapshot over
multiple sessions

Import traces

Stop and destroy
sessions

Network snapshot
session

Record snapshot when
session is inactive

‘Command Script

Execute command sript

Session Profiles

Save session

Save session (2)

Save session (no force)

destroy all sessions

Load Session (local)

destroy all sessions

Load Session (remote)

Open preference (1)

Open preference (2)

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty
4) Select checkbox 'Snapshot Mode'

5) Select 'Ok’

Enable all Kernel Tracepoint and syscall events

a) Select session and click on button 'Start'

b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
‘Record Snapshot' and once with context-sensitive menu item
‘Record Snapshot'

session name ustSession (as described in 18.1)

Enable all UST events

see 18.3

Select kernel and ust session (see 18.1 and 18.5) and click on
'Record snapshot' button

Open Import dialog (see 11.2)

Stop and destroy both sessions

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Open Create Session Dialog box, select 'Snapshot Mode'and
select "Advanced >>>"

3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok

4) Enable events (UST and Kemel), start tracing, and record a
few snapshots, stop tracing

5) Import traces to a existing tracing project

6) Destroy session

Create a command script to create a session with kernel and
ust events enabled.

1) Create Tracing session

2) Select session and click right mouse button
3) Select Menu item "Save..."

4) Select 'OK'

1) Re-do 20.1 (use same session name)
1) Re-do 20.1
but deselect force button

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select a existing profile (from Local)

4) Select 'OK'

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select "Remote”

4) Select a existing profile (from Remote)

5) Select 'OK'

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Manage..."

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Remote Profiles

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

‘Snaphshot ID'
'Snapshot Name' (=snapshot-1)

'Session Path' (=/home/<user>/traces/MySession_<date
and time>) and 'State’ (<INACTIVE)

Make sure that the button and menu item ‘Record
Snapshot' is enabled
Verify that channel and events a successful enabled

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Make sure that the button and menu item ‘Record
Snapshot' is enabled. Also make sure that the Button and
menu item 'Import’ is enabled.

Commands succeed without error

Make sure that snapshot session is created successfully
Verify that channel and events a successful enabled
see 18.3

Command succeeds without error

Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the
selected tracing project

Verify that sessions are destroy successfully

Make sure that all steps were successfull. Also, import
the traces using the standard import instead of the remote
import

Make sure that each command of script is executed and
script execution is without errors

Make sure that the session is saved under ~/.
Ittng/sessions on the remote

Make sure that session is availabe in the workspace by
opening Window->Preferences -> Tracing -> LTTng
Remote Profiles

Make sure that the session is saved under ~/.
Ittng/sessions.

Make sure that session is availabe the user is prompted
to skip or overwrite the profile in the workspace

The save command will be rejected by LTTng Tools

Make sure that the session is created

Make sure that the session is created

Make sure that the LTTng Remote Profile preference
page opens
Make sure that the LTTng Remote Profile preference
page opens

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Manual

SWTBot

Manual

Manual

Manual

command will fail.

Should provide a command script in test spec

Note that the session has to be started at least once otherwise the.
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20.8

20.10

20.11

20.12

21

21.2

N

22.2

223

23

231

233

Export profile

Export profile (redo)

Import profile

Import profile (redo)

Delete profile

Kernel Event Filtering
(LTTng 2.6)

Preparation

Enable Kernel Event on
session level

Enable Kernel Event
from provider

Create trace

LTTng UST Exclude
events (LTTng 2.5)

Preparation

Enable events with
exclude

LTTng UST per syscall
(LTTng 2.6)

Preparation

Enable selected syscalls

destroy session

Enable all syscalls

1) Open Preference page (see 20.7)

2) Select multiple profiles

3) Click on "Export..."

3) Select destination directory and click on "OK"

Redo 20.8

1) Open Preference page (see 20.7)

2) Click on "Import..."

3) Select a profile on media and click on "OK"
1) Redo 20.8

1) Open Preference page (see 20.7)
2) Select multiple profiles

3) Click on "Delete..."

3) Confirm deletion

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.6.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from lttng-tools git repository under
tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession’

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'

4) Select Radio button for "Tracepoint Events'

5) Select one tracepoint

6) Enter filter expression on a event field

7) Click on 'Ok’

1) Execute 14.3

2) Select one Kernel Tracepoint event under Provider "Kernel"
3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly create session and channel

6) Enter filter expression on a event field

7) Click on 'Ok’

1) Start Tracing

2) Stop Tracing after a view seconds

3) Import Trace to Project

4) Open Trace

5) Destroy Session

For the tests below a Ubuntu machine with Ittng tools 2.5.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession’

1) Open Enable Event Dialog, select UST
2) Use wildcards
3) Enter a event name to exclude

For the tests below a Ubuntu machine with Iting tools 2.6.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'MySession'

1) Open Enable Event Dialog, select Kernel

2) Select syscalls

3) In the tree, select selected syscalls

4) Select Ok

1) Open Enable Event Dialog, select Kernel
2) Select Syscalls

3) In the tree, select all syscalls

4) Select Ok

3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Make sure profile is exported to the destination directory
Make sure that user is prompted about to overwrite or
skip existing profile

Make sure profile is imported and available in workspace
Make sure that user is prompted about to overwrite or
skip existing profile

Make sure profile(s) are delete from the workspace and
disk

Verify that default channel (channel0) is create under
domain 'Kernel' and that the corresponding event is
created under the channel with state ENABLED.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter, Filter=the actual expression in LTTng 2.8
+)

Verify that selected event is added under the selected
channel.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter, Filter=the actual expression in LTTng 2.8
+)

Make sure that only events are shown in the events table
that met the condition in the filter expressions

Verify that event is added under the UST Domain and
relevant channel.

Verify that the Properties view shows the exclusion:
Exclusion=with Exclusion, for Exclusion the actual
expression in LTTng 2.8+

Verify that the selectetd syscalls are added added under
the Kernel Domain and relevant channel.

Verify that the selectetd syscalls are added added under
the Kernel Domain and relevant channel.

Manual

Manual

Manual

Manual

Manual

SwtBot

SwtBot

Manual

SWTBot

SWTBot

SWTBot
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3.0.0-TraceCompassTestCases - LTTng 2.0 - Control

Configure JUL tracing ~ Configure JUL tracing session

session (LTTng 2.6) using tree and event name verify that session is configured correctly SWTBot
Configure Log4J tracing Configure Log4J tracing session

session (LTTng 2.6) using tree and event name verify that session is configured correctly SWTBot
Configure Python tracing Configure Python tracing session

session (LTTng 2.7) using tree and event name verify that session is configured correctly SWTBot
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Section
Tracing RCP

Target: Windows 10 64 bit

Step
0

1

1.1

1.2

Test Case
Preparation

1. Download maven 3.3 or above
2. Use openJDK 1.8 or above

3. Use the command mvn clean install -Dmaven.test.skip=true -X

Pass

3.0.0-TraceCompassTestCases - RCP

Fail

Action

4. You might need to use a proxy (adding a settings.xml file in the ~/.m2 folder)
5. Once everything is compiled, you can find the version of RCP for your OS in tracecompass-master/git/org.eclipse.tracecompass/rcp/org.eclipse.tracecompass.rcp.product/target/products/org.eclipse.

tracecompass.rcp/ folder

Start RCP

Start Tracing RCP

Start Tracing RCP with text trace
Start Tracing RCP with previously
opened text trace

Start Tracing RCP with Kernel
CTF trace

Start Tracing RCP with previously
opened Kernel CTF trace

Start Tracing RCP with new trace
with name conflict

Re-do 1.6

Start Tracing RCP with non-trace
file

File menu

Open Trace (File)
Open Trace (File) with previously
opened text trace

Open Trace (Directory)

Open Trace (Directory) with
previously opened Kernel CTF
trace

Open RCP from command line or file explorer

Verification

to compile the RCP without the tests (-X for the debug info)

Tracing RCP opens in default perspective

Open RCP from command line with --open <trace name with absolute

path>

Open RCP from command line with --open <trace name with absolute

path>. Use same trace than 1.2

Open RCP from command line with --open <kernel trace name with

absolute path>

Open RCP from command line with --open <kernel trace name with

absolute path>. Use same trace than 1.4

Trace will be opened with auto-detected trace type

opened and not a new trace entry is created

analysis trace type is selected and trace is opened.

opened and not a new trace entry is created

Open RCP from command line with --open <trace name with absolute

path>, where the name of trace is the same than 1.2, but the trace is

located at a different location on disk

Open RCP from command line with --open <kernel trace with absolute
path>, where name of trace is the same than 1.4, but the trace is

located at a different location on disk

Open file that is not a trace

Verify that the new trace name has a integer number a suffix added.

a integer number a suffix added.

Trace is imported (linked) however default icon (from Eclipse) is set

Use Menu "File -> Open Trace ..." In the file dialog select a text trace

and select open.

Use Menu "File -> Open Trace...". In the file dialog select a text trace

and select open. Use same trace than 2.1

Use "Menu File -> Open Trace ..." . In the file dialog select a file of

Kernel CTF trace directory and select open.

Use "Menu File -> Open Trace ..." . In the file dialog select a file of
Kernel CTF trace directory and select open. Use same trace than 2.3

Trace will be opened with auto-detected trace type
opened and not a new trace entry is created

type is selected and trace is opened.

opened and not a new trace entry is created

Verify that the same trace that was previously linked into the Traces folder is

Tracing RCP is opened, the trace is linked to the Tracing project, the kernel

Verify that the same trace that was previously linked into the Traces folder is

Verify that a new trace is linked to the Tracing project and trace is opened.

Verify that a kernel trace is linked to the Tracing project, the kernel analysis
trace type is selected and trace is opened. Verify that the new trace name has

Verify that the same trace that was previously linked into the Traces folder is

Verify that the trace is linked to the Tracing project, the kernel analysis trace

Verify that the same trace that was previously linked into the Traces folder is

To Do

Comment

[ o [ o e

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Bruno : Not with this test case : If | open n traces, the folder "Traces
[n]" shows the number of traces opened. If i go in the Properties
view with the folder the title of the Properties view is Traces [n], now,
if | delete the n traces the title of the Properties view is still Traces
[n] instead of Traces [0]. Patrick: The Properties view updates itself
when the selection changes.

Bruno : Not with this test case but the delete key doesnt work on
Tracing project (we need to use the mouse right click). Bug 486505.

***(the real test case 1.1 passed)’

The kernel trace opens in an editor but the editor of the first trace
gets activated. Bug 443461.
Bruno : Same bug happens with UST traces

should it open?
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3.0.0-TraceCompassTestCases - RCP

Use Menu "File -> Open Trace ..." In the file dialog select a text trace
Open Trace File with name and select open, where the name of trace is the same than 2.1, but the ~ Verify that the new trace is linked to the Tracing project and the trace is
2.5 conflict trace is located at a different location on disk opened. Verify that the new trace name has a integer number a suffix added. =~ Manual

Use "Menu File -> Open Trace ..." . In the file dialog select a file of
Kernel CTF trace directory and select open, where the name of trace ~ Verify that the kernel trace is linked to the Tracing project, the kernel
is the same than 2.3, but the trace is located at a different location on  analysis trace type is selected and trace is opened. Verify that the new trace

2.6 Re-do 2.5 disk name has a integer number a suffix added. Manual
2.7 Open file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set Manual should it open?
2.8 Restart Use Menu File -> Restart Verify that RCP is restarted with the previously open perspective and trace Manual
2.9 Exit Use Menu File -> Exit Tracing RCP exits Manual

3.1 Open Perspective Use Menu Window -> Show Perspective -> Tracing Perspective Tracing perspective is opened Manual
Use Menu Window -> Show View -> Select Tracing -> Sequence

32 Open View Diagram Sequence diagram view is shown Manual

33 Preferences Use Menu Window -> Preferences Preferences dialog is shown Manual

Make changes of perspective by moving views and use menu Window
3.4 Save Perspective As -> Save Perspective As. Enter a perspective name and select Ok Perspective with new name is stored Manual

Make changes of perspective by moving views and use menu Window After confirming the reset operation the perspective is reset to the default
35 Reset Perspective -> Reset Perspective. layout. Manual

Help Contents Use Menu -> Help -> Help Contents
42 Help Contents (shortcut) Use key F1 Help content browser is opened. All Tracing related help is included Manual

Use Menu -> Help -> Install New Software... to install new Eclipse
42 Install new Software feature Installation is successful Manual

Help content browser is opened. All Tracing related help is included

About dialog is opened all relevent information (e.g. version, copyright years
4.4 About Use Menu -> Help -> About etc) is up-to-date and correct. Manual
Go over all tracing features and plug-ins and verify that all have the correct
version and copyright years

Version + Copyright Use Menu -> Help -> About -> Installation details Trace Compass RCP Branding Plug-in has 2016 copyright year

TMEF presence Open Tracing perspective Tracing perspective opens Manual

52 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective opens Manual
53 PCAP Network analysis presence Open Network Tracing perspective Network analysis perspectiv opens Manual
5.4 BTF presence Open BTF trace BTF trace opens correctly Manual

6.1 Upgrade from previous release Use Help -> Check For Updates RCP is upgraded Manual Tested with RC3
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3.0.0-TraceCompassTestCases - TraceSynchronization

Section ToDo Comment

Trace Synchronization

Target:
Step Test Case Action Verification Comment
0 Prerequisites
Import the scp_dest and scp_src traces in the
0.1 Import traces synctraces.tar.gz file
0.2 Create experiment 1 Create an experiment containing those 2 traces
0.3 Create experiment 2 Create an experiment with any other trace
1 View Management
Use menu Window — Show View — Tracing —
1.1 Open Synchronization View  Synchronization Verify that 'Synchronization' view is shown Manual Pass This view should be in properties I agree
1.2 Delete view Close the Synchronization View Synchronization' view is removed from perspective Manual Pass The view also makes no sense to mere mortals.
Use menu Window — Show View — Tracing —
1.3 Open view Synchronization Synchronization' view is displayed and remains empty Manual Pass
Open the experiment containing the 2 synchronizable
1.4 Open Experiment traces Verify that the view is still empty Manual Pass
After a time, the view is populated with synchronization result
Right-click on the experiment and select 'Synchronize that say 'accurate’. And one of the original traces has been
1.5 Synchronize experiment Traces' replace by a trace with the same name, but with an'_'at the end.  Manual Pass
1) Close Synchronization View
Open view when trace is 2) Load LTTng experiment Verify that view is populated with synchronization data from
1.6 already loaded 3) Open 'Synchronization' view currently opened experiment Manual Pass
Synchronize experiment with
1.6.5 constant offset Try to offset a trace by a second Visually verify that a synchronized trace is now offsetted Manual Pass
1.7 Open trace Open an Lttng Kernel trace Synchronization view is empty Manual |- Pass |
1.8 Re-open experiment Open the experiment containing the 2 synchronized traces View shows synchronization data from the experiment Manual | Pass | fixed with https://git.eclipse.org/r/#/c/98366/
Verify that view is populated with synchronization data from
1.9 Restart Restart Eclipse experiment Manual Pass
2 Functionnalities
Open the experiment containing traces that do not
2.1 Open experiment 2 synchronize Verify that the 'Synchronization' view is empty Manual | Pass
Go back to previous Re-open the experiment with the synchronizable Verify that the 'Synchronization' view contains the data
2.2 experiment traces from the experiment Manual | Pass | https://git.eclipse.org//#/c/98366/
After the syncronization job finishes, the synchronized
Right-click on the experiment and select experiment is closed and experiment 2 is selected. The Absent is not displayed, the view is empty. Patrick:
2.3 Synchronize experiment 'Synchronize traces' synchronization view is empty. Manual Pass Updated the verification text
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3.0.0-TraceCompassTestCases - LTTng 2.0 - Memory analysis

Section Type ToDo Comment

LTTng 2.0 - Memory
Analysis 13
Target: Ubuntu 14.04 64 bit
Step Test Case Action Verification Type Comment
0 Prerequisites
Download UST trace with memory events
from https://secretaire.dorsal.polymtl.
0.1 Download traces cal/~gbastien/traces/eclipse_mem_ust.tar.gz
Import trace with memory  Import the LTTng UST trace downloaded
0.2 event above in Tracing project
Import one of the LTTng UST trace that
Import trace without does not contain the memory events, for
0.3 memory event example, the one used for the callstack view
0.4 Import non-UST trace Import one LTTng Kernel trace
1 Project View
open the trace that contains the memory
Check analysis can events. In the project explorer, expand the
11 execute trace that contains the memory events "Ust Memory" analysis is present and "normal” SWTBot Pass 84702
In the project explorer, open and expand
the trace that contains the memory events,
Verify help message when  right-click the memory analysis and select
1.2 applicable Help A generic help message appears with the name of the analysis. Manual Pass
open the trace that contains the memory
events. In the project explorer, expand the
Check analysis cannot UST trace that does not contain memory
1.3 execute events "Ust Memory" analysis is present, but striked-out Manual Pass 84702
In the project explorer, open and expand
the UST trace that does not contain memory
Verify help message when events, right-click the memory analysis and The help message mentions the analysis is impossible to
1.4 not applicable select Help execute and contains the requirement that is not fulfilled Manual Pass
Check analysis for another In the project explorer, expand a LTTng
1.5 trace type Kernel trace "Ust Memory" analysis is not present SWTBot Pass 84702
2 View Management
Open the UST trace with memory events
and expand the "UST Memory" analysis in
21 Populate analysis's view the project explorer "Ust Memory Usage" View appears under the analysis SWTBot Pass
Double-click the UST Memory View under  The UST Memory Usage view opens and triggers the memory
22 Open view the memory analysis analysis. After the analysis, the XY chart is populated SWTBot Pass
23 Close trace Close the trace The UST Memory Usage view is emptied. Manual Pass
With the view already opened, open the View not populated. Bug 467751. JC: Works for
24 Open trace trace The UST Memory Usage view is populated. SWTBot Pass me
25 Close view Close the UST Memory Usage view The view is closed. Manual Pass

Double-click the UST Memory Usage view
under the memory analysis in project

2.6 Re-open view explorer. The view opens and is automatically populated. Manual Pass
3 Mouse handling

Drag move xy chart left and right with Time range is dragged. When mouse button is released, the
3.1 Drag move time range middle button view refreshes with the new time range Manual Pass
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3.2

3.3

3.4

3.5

3.6

3.7

3.8

4.1

4.2

43

Zoom time range (mouse
wheel)

Drag select time range

Mouse hover

Drag mouse selection

Shift key selection

Drag mouse selection
(Status bar)

Shift key selection (Status
bar)

Synchronization

Preparation

Time synchronization

Time range synchronization

Time range selection
synchronisation

3.0.0-TraceCompassTestCases - LTTng 2.0 - Memory analysis

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Drag select time graph with right button

Hover mouse in xy chart anywhere

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view

Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time
range is propagated to other views.

Tool tip shows values for each thread at the given timestamp

Selection highlighted. New selection is propagated to other
views

Selection highlighted. New selection is propagated to other
views

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selected time line is updated.

Time range is updated.

Selection range is highlighted.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

The tooltip is not aligned with the selection when
hovering multiple times
Bernd: | cannot reproduce this problem

What is the difference between 3.5 and 3.7?
Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts. So
we should not test for it

Status bar not updated

time range is NOT updated to include the new
selection. The range update seems to not work
with UST traces. Patrick: Only time graph views
update their window range to ensure selection is
visible.

Ithink this test is for window range. | have this
exception : Exception in thread "Line chart
update" org.eclipse.swt.SWTException: Invalid
thread access

(Invalid Thread access bug: https://bugs.eclipse.
org/bugs/show_bug.cgi?id=513013)

time range is NOT updated to include the new
selection. The range update seems to not work
with UST traces:

Patrick: Only time graph views update their
window range to ensure selection is visible.
(Invalid Thread access bug: https://bugs.eclipse.
org/bugs/show_bug.cgi?id=513013)
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Target:

Step

0
0.1
1

22
23
24
25

Section
LTTng 2.0 - CPU Analysis

Test Case

Prerequisites
Import traces
Project View
Check analysis can

execute

Verify help message when
applicable

Check analysis for another

trace type

View Management
Populate analysis's view
Open view

Close trace

Open trace
Close view

Re-open view
View selection

Select an entry

Select another entry
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

3.0.0-TraceCompassTestCases - LTTng 2.0 - CPU analysis

Pass

Action

Import LTTng Kernel traces in Tracing project

In the project explorer and expand a LTTng
Kernel trace

In the project explorer, open and expand the
LTTng kernel trace, right-click the CPU usage
analysis and select Help

In the project explorer, expand a non-LTTng
Kernel trace

Open an LTTng kernel trace and expand the
"CPU usage" analysis in the project explorer

Double-click the CPU usage View under the
CPU usage analysis

Close the trace
With the view already opened, open the trace
Close the CPU Usage view

Double-click the CPU Usage view under the
CPU usage analysis in project explorer.

Select an entry in the tree viewer section

Select another entry from the tree viewer

Drag move xy chart left and right with middle
button and shift mouse wheel

Zoom with ctrl mouse wheel up and down,
cursor inside xy chart

Scroll with mouse wheel up and down, cursor
outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right button in xy
chart

Fail

Verification

"CPU usage" analysis is present and it's not crossed out

A generic help message appears with the name of the
analysis

"CPU usage" analysis is not present

"CPU Usage" View appears under the analysis

The CPU usage Usage view opens and triggers the cpu
analysis. After the analysis, both tree viewer and xy charts
are populated.

The CPU Usage view is emptied.

The CPU Usage view is populated.

The view is closed.

The view opens and is automatically populated.

A new series is added to the xy chart, corresponding to the
selected TID

A new series is added to the xy chart, and the previous TID's
series is not displayed anymore

Time range is dragged. When mouse button is released,
series are updated and new time range is propagated to other
views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,
including the tree viewer beside the chart. The selected
process remains the same.

Table scroll up and down. Selected process does not change.
Vertical scroll bar updated.

Tree viewer scrolls up and down. Selected process does not
change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
time range is propagated to other views. Selected process
remains the same.

Type To Do
0 0

Type
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
7

Comment

84702
Sonia: The help message doesn't explain the
role of the view or how to use it. There should
be more details available

84702
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3.0.0-TraceCompassTestCases - LTTng 2.0 - CPU analysis

Tool tip shows the total and selected process (if any) cpu

4.6 Mouse hover Hover mouse in xy chart region anywhere usage at the time Manual
Selection highlighted and selection range is propagated to
4.7 Drag mouse selection Drag select xy chart with left button other views Manual
Click select with left button (begin time), press
shift key and click select another time (end Selection highlighted and selection rang is propagated to
4.8 Shift key selection time) other views Manual
Entries are sorted in ascending then descending order on the
4.9 Sort columns Click on column headers once then twice column value. Selected process does not change. Manual Column TID should use Integer sorting.
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
] the mouse position, Tj the first selected‘tlme,_TZ the second Status bar is not updated. Note that the status
Drag mouse selection (draggged) selected time and delta the time difference bar hasn't been implemented for XY charts. So
4.10 (Status bar) Drag select xy chart with left button between T2-T1 (can be negative) Manual N/A we should not test for it
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
Click select with left button (begin time), press the mouse position, T1 the first selected time, T2 the second
Shift key selection (Status  shift key and click select another time (end (draggged) selected time and delta the time difference
4.1 bar) time) between T2-T1 (can be negative) Manual N/A Status bar not updated
5 Keyboard handling
Keyboard navigation in tree  With focus on table, use UP, DOWN, HOME,  Selected process is changed. xy chart selection is updated.
5.1 viewer END keys Vertical scroll bar updated. Manual
6 Synchronization
Selected time line is updated. If selected time is outside
6.1 Time synchronization Select a random time in another view current range, time range is updated to include it. Manual
Select a new time range in CPU usage view or
6.2 Time range synchronization in Histogram view. Time range is updated. Manual
Selection is highlighted. If the most left time (T1) of selected time
Time range selection In any other view that supports range range is outside the current range, then time range is updated to
6.3 synchronisation synchronization, select a new range. include it Manual

CPU usage works with
experiments

Manual

Sonia : The cpu usage works only on
experiments with one trace , it would be nice if
it displays the CPU usage of two traces per
example in the same graph

works wit 1 kernel
trace experiments
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Section

Network Trace analysis

Target: Ubuntu 14.04 64 bit

Step

0
0.1
1

Test Case

Prerequisites
Import traces
Trace Import

Open the Network Tracing
perspective

Open trace
View management
Populate the views

Look up stream

Close the trace
Close view

Open view when trace is
already loaded

Open a non pcap trace
Stream List
Re-open trace

Create a filter from the
stream list

Apply filter

3.0.0-TraceCompassTestCases - Network Analysis

Pass
11

Action

Import the trace linked here

In the project Explorer, expand any LTTng kernel
trace

Double-click on the "TeamSpeak2.pcap" trace

Open the "TeamSpeak?2.pcap"
Open the Stream List view

Close the trace
Close the Stream List view

Re-open the trace. Open The Stream List view

Close the trace

Ensure only "TeamSpeak2.pcap" is opened

Right click on stream 0, and select "Extract as
Filter"

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
29.."

11

Verification

Verify that the events view, the properties and stream list
are displayed

The trace is given a "network" icon. When openned, the
events view and histogram view is opened

The views are updated

One stream is available with endpoint A being 00:0c:29:
7c:ab:f9

The stream list is emptied

The view is closed

The view opens with the correct title and is correctly
populated.

The stream list is emptied

The trace is opened

A filter named "FILTER stream eth 00:0c:29..." is
created

24/24 events pass the filter

To Do
3 0
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
0

Comment

In SWTBot other trace is used
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Target:

0.1

0.2

0.3

2.1

22

23

2.4

2.5
2.6
2.7
2.8
2.9

3.1

3.1

Section
XML analysis
Ubuntu 14.04 64 bit

Test Case

Prerequisites
Import traces

Get a test XML file

Make sure the XML file does
not exists in the project

XML file handling
Verify analysis not present

Import XML file

Edit XML file
View management

Populate the views

Open the "Xml Control Flow
View'

Open another XML view
Close view

Open view when trace is
already loaded

Close traces

Open trace

Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

3.0.0-TraceCompassTestCases - XMLanalysis

Import LTTng kernel traces

Download the test XML file here: https://secretaire.
dorsal.polymtl.ca/~gbastien/Xml4Traces/Kernel.Linux.
xml

Open the Manage Xml Analyses menu and delete the

XML file if it exists (or The XML files are located in

<workspace directory>/.metadata/.plugins/org.eclipse.
tracecompass.tmf.analysis.xml.core/xml_files. Delete

the linux kernel XML file if it exists.)

In the project Explorer, expand any LTTng kernel trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the Kernel.
Linux.xml file and close the dialog.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.Linux
and click Edit

Open an LTTng kernel trace (eg trace2 from the
tracecompass-test-traces repo)

Double-click the "Xml Control Flow View' under the
analysis

Double-click the 'Xml Resources View' under the
analysis

Close both XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace

Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Verification

NOTE: XML haven't files haven't been update to latest Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the "Xml kernel State System' analysis is now present
under a LTTng kernel trace

Verify that the XML editor opens. The editor should have Design
and Source sub-tabs

The 'Xml kernel State System' analysis should have a + next to it,
expand it and there should be 2 views under it: 'Xml Control
Flow View' and 'Xml Resources View'

A view titled 'Xml Control Flow View' should open and it should
look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it should
look quite similar to the Resources view's CPU entries. Both
XML views are opened.

The view are closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated

The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

To Do

Comment

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Comment

stateSystemView section does not
appear as XML

70



2.3

4.1

4.2

43

44

4.5

4.6

4.7

4.8

4.9

4.10

‘Select state in time graph

Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

3.0.0-TraceCompassTestCases - XMLanalysis

‘Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with CTRL + mouse wheel up and down, cursor
inside time graph

Drag in time graph scale left and right with left button
Scroll with mouse wheel up and down, cursor outside

time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are

synchronized to selected time.

Time range is dragged. When mouse button is released, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor. When
mouse wheel is stopped for a short time, states are updated and
new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to
other views.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time range
is zoomed to selection, states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end time,
duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

"the new window range"

71



4.11

5.1

52

5.4

5.4

6.1

6.2

6.3

6.4

6.5
6.6

6.7

7.1

7.2

Shift key selection

Keyboard handling

Keyboard navigation in table
(entry selection)

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time
graph (process selection)

Keyboard navigation in time

graph (state selection)

Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes

Synchronization

Time synchronization

Time range synchronization

3.0.0-TraceCompassTestCases - XMLanalysis

Click select with left button (begin time), press shift

'key and click select another time (end time)

With focus on table, use UP, DOWN, HOME, END
keys

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use SHIFT LEFT, RIGHT keys while parent
or child process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

- With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button
Click Previous/Next interval button
Click Zoom In/Out button

Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes

'3) Press Ok

Select a random time in another view

Select a new time range in Resources view or in
Histogram view.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between

'T2-T1 (can be negative)

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in

other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected interval (process/resource) is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time range.

States are updated and new time range is propagated to other
views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Passed on Linux.

Comment from 1.0 testing: Not all displayed
colors are in the legend

This is still a problem in 1.1 when using
traces generated with LTTng 2.6 and older

More filter buttons are available in cfv
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7.3

Time range selection
synchronisation

3.0.0-TraceCompassTestCases - XMLanalysis

Selection is highlighted. If begin time (T1) of selected time range

In any other view that supports range synchronization, is outside the current range, then time range is updated to include

select a new range.

it

Manual

73



Target:

Step

0

Section
Critical path

Test Case

Prerequisites

Import traces

Pass
43

Action

Import the 3
django traces from
the test traces

Create an
experiment with

Create experiment the 3 traces in it

Synchronize
experiment

View
management

Open trace

Open experiment

Open view

Close view

Synchronize the
experiment, it
should be
accurate and 2 of
the traces will be
udpated

Open any of the
django traces in
Project Explorer

Open the django
experiment in
Project Explorer

Expand the Views
element, then the
Critical Path
analysis and click
on the Critical
Flow View

Close the Critical
Flow View

3.0.0-TraceCompassTestCases - Critical Path

Fail To Do
2 0

Verification

Expand the Views element under the trace.

The LTTng Kernel Exec Graph analysis is

there and "normal". The Critical Path

analysis is there and the Critical Flow view

is available under it. Manual Pass

Expand the Views element under the trace.

The LTTng Kernel Exec Graph analysis is

there and "normal". The Critical Path

analysis is there and the Critical Flow view

is available under it. Manual Pass

Critical Path view is opened and empty SWTBot Pass

Critical Path view is closed Manual Pass

Comment
10

Comment
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1.5

1.6

2.1

2.2

2.3

2.4

2.5

255

Unapplicable trace

Unapplicable

experiment

View population

Populate the view
with trace

Select worker in
time graph

Select state in
time graph

Select worker in
tree viewer

Populate the view
with empty path

Select again

3.0.0-TraceCompassTestCases - Critical Path

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open a trace that not there. The Critical Path analysis is there

isnotaLTTng and the Critical Flow view is available under
kernel trace it.
Open an Expand the Views element under the trace.

experiment that The LTTng Kernel Exec Graph analysis is
does not contain  there, but striked out. The Critical Path

LTTng kernel analysis is there and the Critical Flow view
traces is available under it.
With the django-

client trace and

the critical path

view opened, in

the control flow

view, find the

process named

python (TID 9496).

Right-click on the

process and select The LTTng kernel exec graph is executed
"Follow and at the end, the critical path view shows
python/9496" the interaction between 3 workers.

Select an empty  Same process is highlighted in table.
region in the time  Selected time line is updated. Other views
graph section are synchronized to selected time.

Same process is highlighted in table. State
is highlighted in time graph. Selected time
Select a state in  line is updated. Other views are
the time graph synchronized to selected time.

Select a worker
from the tree
viewer section Same process is highlighted in time graph.

Repeat steps of

2.1, with django-

client trace and

process Ittng-

sessiond (TID

9355) The Critical Path View is emptied

Repeat steps of
2.1, and select
python/9496 again The critical path should be the same as 2.1

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Done in SWBot with another trace

But there should be a message telling why it is empty
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2.6

2.7

2.8

3.1

3.2

3.3

3.4

3.5

3.6

Re-opening

Populate the view
with experiment

Populate with
trace with time
selection

‘Mouse handling

Drag move time
range

Zoom time range
(mouse wheel)

Zoom time range
(mouse drag)

Mouse vertical
scroll

Vertical scroll bar

Drag select time
range

Close the django-
client trace,
reopen it and
repeat steps of 2.1

Repeat steps of
2.1, but with the
django-experiment
instead

Re-open django-
client trace. In the
Control Flow View,
select a time after
the python
process exited,
then follow the
python/9496

process

Ctrl-Drag move
time graph left and
right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

Drag in time graph
scale left and right
with left button

Scroll with mouse
wheel up and
down, cursor
outside time graph

Click and drag
vertical scroll bar

Drag select time
graph with right
button

3.0.0-TraceCompassTestCases - Critical Path

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed
and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Path View should be populated

like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

Table and time graph scroll up and down
and remain aligned. Selected worker does
not change. Vertical scroll bar updated.

Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Everything works but is unuseably slow

zoom on 4 lines?

76



3.7

3.8

3.9

3.10

3.1

41

4.2

4.3

4.4

5.1

‘Shift key selection

Double-click reset
time range

Mouse hover
(empty region)

Mouse hover
(state)

Drag mouse
selection

Keyboard
handling

Keyboard
navigation in table
(process selection)

Keyboard
navigation in table
(tree expansion)

Keyboard
navigation in time
graph (process
selection)

Keyboard

navigation in time
graph (state

selection)

Tool bar handling '

Align views

Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another

‘time (end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,

in Windows use LEFT,

RIGHT keys while trace
or worker is selected

in Linux use SHIFT
LEFT, RIGHT keys while
trace or worker is
selected

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,
RIGHT keys

Click on the Align View
Button, with another time
graph view, eg the
Control Flow view
opened above or under

3.0.0-TraceCompassTestCases - Critical Path

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name only.

Tool tip shows worker name, state name, priority, date,
start time, end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time

difference between T2-T1 (can be negative)

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For trace, tree is expanded or collapsed. Time graph item
expansion is updated. Vertical scroll bar updated. For
workers, it does nothing.

Selected worker is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected

time is updated in other views.

When it is pressed, moving the line between tree viewer
and time graph will move the line of the other view. If not
pressed, the line can be moved without affecting the other
views

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

OMG SO SLOW

Tested in Linux

Views align whether link views is selected or not
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5.2

5.3

54

5.5

5.6

5.7

5.8

5.9

5.11
5.12

6.1

6.2

6.3

Show Legend

Reset Time Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

Synchronization

Time
synchronization

Window range
synchronization

Selection range
synchronization

Click Show
Legend button

Click Reset Time
Scale button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom In/Out
button

Select a time, and click
on the Add Bookmark
button

Add more bookmarks,
then click on the
next/previous marker
buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark button

Click on the down arrow
at the extreme right of
the view, then expand
Show markers and
uncheck the Bookmarks
box

Same as above, recheck

the Bookmarks box

Select a random
time in another
view

Select a new window
range in another view
In any other view
that supports
selection range
synchronization,
select a new
range.

3.0.0-TraceCompassTestCases - Critical Path

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.

The bookmark is added and is displayed in the other views
as well (if enabled)

The time graph view navigate between the bookmarks,
States are updated and time selection is propagated to
other views. When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

All remaining bookmarks disappear from the view, but
remain in other views where the they are enabled

The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Marker context menu does not work, view context menu works

Marker context menu does not work, view context menu works
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3.0.0-TraceCompassTestCases - Critical Path

With a critical path
displayed, select a
time in another view
that is not in the range
of the process being
displayed in the critical Selected time is updated and the critical path view is
6.4 Out of region selection path view synced with the other Manual




3.0.0-TraceCompassTestCases - Lami

Section To Do Comment

Target: Ubuntu 14.04 64 b

Step Test Case Action Comment
0
0.1 Import traces any trace since we use stub for the result
Download analysis  https://bugs.eclipse.org/b hment.cgi?id=263946
0.2 stubs from bug: https://bugs.eclipse.org/bugs/show_bug.cgi?id=493941
Custom
external
1 analysis
Create the following analysis ($name, $command): All new external analysis are present under the "External Analysis"
node in the Project explorer view.
analysisEmpty, analysisEmpty All new elements do NOT have the strikethrough text style applied
lysisMultipleRow, lysisMultipleRow EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)
lysisM imilarRow, analysisMulti| imilarRow
analysisOneRow, analysisOneRow
multipleReports, multipleReports
invalidAnalysis, invalidAnalysis
errorResult, errorResult
clone, analysisOneRow
Right click on "External Analyses" node
Click the "add" action
Insert $name
Insert "fullpath/$executable” which is the full path to the stub executable.
ex:"/tmp/stub/stubAnalysis" where stubAnalysis is the stub executable
Add all stubs The path do NOT support ~ or relative path
1.1 analysis Takes a long time to be not struck through
1.2 Actions availables  Right click on a non-strikethrough custom analysis. The run action can be clicked and in enabled text mode.
Actions avaliables  Right click on a strikethrough custom analysis. The run action CANNOT be clicked and is in disabled text mode.
Right click on the tuple (clone, invalidAnalysis)
13 Delete analysis Select the delete action for the node The analysis does not appear in the list anymore.
analysisEmpty should return a message to the user regarding the emptiness of the report.
errorResult should return an error message to the user and display the result of the com
14 Run analysis Launch remaining analysis via righ-click and run action Al other one have result and should result in a new table and new report node under the
2 Reports

The "Reports" node under the Project Explorer should contain 4 report:
analysisMultipleRow Report
analysisMultipleSimilarRow Report
analysisOneRow Report
21 Reports node Expand the "Reports" node under the Project Explorer multipleReports

An additional node should be present under the "Reports” node:
analysisOneRow Report #2

Note: This behaviour is subject to change in the following year but

22 Same name report Execute the "analysisOneRow" analysis again. still an action will be taken on same name report creation.
23 Delete node Right click on the duplicate "analysis OneRow" node and click on the delete action The node reports is not present anymore
2.4 Open a report Right click on any report and select the "open" action A new panel should open with the result table of the analysis
Open the same
25 report again Right click again on the same report to open it A new panel should open with the result table of the analysis
2.6 Multiple report Open the "multipleReports" report. Validate that a user is able to navigate between sub tab of a report
3 Result Table
3.1 Prerequisites Open the "analysisMultipleRowReport"
3.2 Hide table Click the "Toggle" button in the right corner of the result table The result table is hidden
3.3 Show table Click the "Toggle" button in the right corner of the result table The result table is shown
Sort all column by clicking on the column name. Clicking multiple time on the name should change the ordering
34 Sorting sorter. Validate that the order make sense
35 Colum Resizing Resize the column Validate that the resize works
3.6 Multiple selection  Select multiple rows by holding ctrl and clicking on multiple unselected rows of the table Multiple selections are highlighted in the table
3.7 Unselect selection  Deselect multiple rows by holding ctrl and clicking on multiple selected rows of the table The clicked row should not be selected anymore
4 Bar Chart
4.1 Create Use the menu on the upper right of the result table and select "create bar chart" Note: a bar chart does NOT perform agregation of categories values
4.2 Series dialog add ~ Select any x and any y click add Series are added to the series list
Series dialog
43 remove Remove all newly created series via the delete button User should be able to delete series




4.4

4.5
46

4.7

4.8

4.9

4.10

5.1

5.2
5.3
5.4
55
5.6
57

Creat chart

Selection
Multi selection

Deselection

Y axis

Keep the chart
open

Hide the table
results

Scatter Chart
Create

Creat chart
Selection

Multi selection
Deselection
Mouse hovering

Full deselection

Select any x and y and click add and "ok"

Click on any bar inside the chart

Ctrl+click on other unselected bar

Ctrl+click on other selected bar

Recreate the same graph but with the y log scale option enabled

Keep the chart open

Hide the table results

Use the menu on the upper right of the result table and select "create scatter chart"

Select any x and y and click add and "ok"
Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart
Hover mouse in the graph

Click in the chart when no hovering cross is present

3.0.0-TraceCompassTestCases - Lami

A bar chart should be created
Note: a bar chart does NOT perform agregation of categories values

The corresponding row should be selected in the table and the chart
should highlight the selected bar

Selections should be highlighted in the result table and the chart

The clicked bar should be removed from selection and the resuit
table update with the current selections

Y axis should be in log scale mode
Note: check for zero value and negative handling since log scale do
not support zero and negative

A scatter chart should be created

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

On mouse hovering a cross should snap to the nearest point
All selected objects should be deselected
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3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Section
LTTng 2.0 - I/O

Analysis
Target:
Step Test Case Action Verification
0 Prerequisites
Import LTTng
Kernel traces in
0.1 Import traces Tracing project
1 Project View
"Input/Output”
In the project analysis is
explorer, present and
Check analysis expand a LTTng "normal" (not
1.1 can execute Kernel trace striked-out)
In the project
explorer, open
and expand the
LTTng kernel A generic help
trace, right-click message
Verify help the Input/Output appears with
message when analysis and the name of the
1.2 applicable select Help analysis

To Do

SWTBot

Manual

Pass

Pass

Comment

Comment

Bruno : In the
'Views' tree item,
there is a
Input/Output item,
but im not sure
what it means to be
'normal’
Genevieve: normal
is not striked-out
(added it to the
verif step), itis a

pass

Bruno : The help
message doesn't

explain much

84702
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1.5

2.1

2.2

2.3

24

2.5

Check analysis
for another

trace type

View
Management

Populate
analysis's view

Open view

Close trace

Open trace

Close view

3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

In the project
explorer,
expand a non-
LTTng Kernel

trace

Openan LTTng
kernel trace and
expand the
"Input/Output”
analysis in the
project explorer

Double-click the
Disk 1/0 Activity
View under the
Input/Output
analysis

Close the trace

With the view
already opened,
open the trace

Close the Disk
I/O Activity view

"Input/Output”
analysis is not

‘present

"Disk I/0O
Activity" View
appears under
the analysis

The Disk 1/0
Activity view
opens and
triggers the
input/output
analysis. After
the analysis, the
Xy charts is
populated.
The Disk 1/0
Activity view is
emptied.

The Disk I/0
Activity view is
populated.

The view is
closed.

SWTBot

SWTBot

Manual

Manual

Manual

Manual

84702
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3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Double-click the
Disk I/0O Activity
view under the The view opens
Input/Output and is

analysis in automatically
project explorer. populated.

Re-open view Manual

Time range is
dragged. When
mouse button is
released, series
Drag move xy  are updated and
chart left and new time range
Drag move time right with middle is propagated to
4.1 range button other views. Manual

Time range is
zoomed in and
out, relative to
MOUSE CUrsor.
When mouse

wheel is
stopped for a
short time,
Zoom with series are
mouse wheel up updated and
Zoom time and down, new time range
range (mouse  cursor inside xy is propagated to
4.2 wheel) chart other views. Manual
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4.3

4.4

4.5

4.6

Drag zoom time
range

Mouse hover

Drag mouse
selection

Shift key
selection

3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Drag select time
graph with right
button in xy
chart

Hover mouse in
Xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.

Tool tip shows
the puntual disk
activity, with
units in <unit>/s

Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection rang is
propagated to
other views

Manual

Manual

Manual

Manual

Bruno : The tool tip
is showing but is
not folowing the
mouse, so the infos
are updated but the
black box remain at
the original place.
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4.70

Drag mouse
selection
(Status bar)

3.0.0-TraceCompassTestCases - LTTng 2.0 - I/0 analysis

Drag select xy
chart with left
button

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative) Manual

Status bar is not
updated. Note that
the status bar
hasn't been
implemented for
XY charts. So we
should not test for it

86



3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected

time, T2 the
second
Click select with (draggged)
left button selected time

(begin time), and delta the

press shift key time difference
Shift key and click select between T2-T1
selection another time (can be Status bar not
(Status bar) (end time) negative) updated

Selected time
line is updated.
If selected time
is outside
current range,
Select a random time range is

Time time in another updated to

6.1 synchronization view include it. Manual
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6.2

6.3

6.4

Time range
synchronization

Time range
selection
synchronisation

Disk I/0O Activity

works with
experiments

3.0.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Select a new
time range in
Disk I/0O Activity
view or in
Histogram view.

In any other view
that supports
range
synchronization,
select a new
range.

Time range is
updated.

Selection is
highlighted. If the
most left time
(T1) of selected
time range is
outside the
current range,
then time range is
updated to
include it

Manual

Manual

Manual
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Target:

Step

0

0.1

0.2

0.3

0.4

1.1

Section

LTTng 2.0 - VM
Analysis

Test Case Action

Prerequisites

Download
traces here:
https:
/Isecretaire.
dorsal.polymtl.
ca/~gbastien/tra
cingSummit201
4/mpi_traces.
tgz and import
the 3 kernel
traces in the
Import traces vmnet directory

Create an
Create experiment with
experiment the 3 traces in it

Synchronize the
experiment, it
should be
accurate and 2
Synchronize of the traces will
experiment be udpated

Right-click the

experiment,

click "Select

experiment

type..." and

select "Virtual
Set experiment Machine

type Experiment"
View
management
Expand the
Views element
Analysis of the
present experiment

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

To Do

Verification

The Virtual

Machine

Analysis is

present Manual

Pass

Comment

Comment

89



1.2

1.3

1.4

1.6

21

2.2

Open
experiment

Open view

Close view

Unapplicable
experiment

Populate the
view with
experiment

View guest's
threads

Open the vm
experiment in
Project Explorer

Expand the
Views element,
then the Virtual
Machine
analysis and
click on the
Virtual CPU
View

Close the
Virtual CPU
View

Open an
experiment that
is not of Virtual
Machine
Experiment type

With the VM
experiment,
open the Virtual
CPU View

Expand the

Expand the
Views element
under the trace,
then the Virtual
Machine
Analysis
element. The
Virtual CPU
view is present

Virtual CPU
view is opened,
the virtual
machine
analysis is
triggered and
the view gets
filled

Virtual CPU
view is closed

Expand the
Views element
under the trace.
There is no
Virtual Machine
Analysis.

The view is
populated with
the VM element
as the only
parent and 2
virtual guests
having 3
VCPUs each
and a collapsed
Threads entries

A list of
processes is
shown, in
numerical order
and their time

Threads entry of graph viewer

a guest

part is filled

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Manual

Manual

Manual

Manual

Manual

Manual

launches kernel exec graph which take a very long time, slow indexing throughput
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2.3

24

2.5

3.1

3.2

VM specific
states

Preempted
thread states

Re-opening

Drag move time
range

Zoom time
range (mouse
wheel)

Zoom in the
VCPUs time
graph around
the "interesting"
region, where
there is more
action (around
the second half
of the trace)

Select a region
with the
CPU_PREEMP
TED state and
scroll down the
threads entries
to around 405-
406: mpi-
imbalance
processes

Close the VM
experiment,
reopen it

Ctrl-Drag move
time graph left
and right with
middle button

Zoom with
mouse wheel up
and down,
cursor inside
time graph while
holding the Ctl
button

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

2 new states
are easily
recognizable:
WAIT_VMM
and
VCPU_PREEM
PTED

We can observe
alpha'ed states
corresponding
to the cpu
preempted
states

The view is
populated again

Time range is
dragged. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out, relative to
mouse cursor.
When mouse
wheel is
stopped for a
short time,
states are
updated and
new time range
is propagated to
other views.

Manual

Manual

Manual

Manual

Manual
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3.3

34

3.5

3.6

3.7

3.8

3.9

Zoom time
range (mouse
drag)

Mouse vertical
scroll

Vertical scroll
bar

Drag select time
range

Double-click
reset time range

Mouse hover
(empty region)

Mouse hover
(state)

Drag in time
graph scale left
and right with
left button

Scroll with

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Time range is
zoomed in and
out. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Table and time
graph scroll up
and down and
remain aligned.
Selected worker

mouse wheel up does not

and down,
cursor outside
time graph

Click and drag
vertical scroll
bar

Drag select time
graph with right
button

Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

change. Vertical
scroll bar
updated.

Table and time
graph scroll up
and down and
remain aligned.
Selected
process does
not change.

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, states
are updated and
new time range
is propagated to
other views.
Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.
Tool tip shows
process name
only.

Tool tip shows entry
name, state name,

date, start time, end
time, duration.

Manual

Manual

Manual

Manual

Manual

Manual

Manual
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3.10

3.1

4.1

4.2

4.3

44

Drag mouse
selection

Shift key
selection

Keyboard
navigation in
table (process
selection)

Keyboard
navigation in
table (tree
expansion)

Keyboard
navigation in
time graph
(process
selection)

Keyboard
navigation in
time graph

Drag select time
graph with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,
in Windows use
LEFT, RIGHT keys
while expandable
element is selected

in Linux use SHIFT
LEFT, RIGHT keys
while expandable
element is selected
With focus on
time graph, use
UP, DOWN,
HOME, END
keys

With focus on
time graph, use
LEFT, RIGHT

(state selection) keys

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative)

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative)

Selected entry
is changed.
Time graph
selection is
updated.
Vertical scroll
bar updated.

For expandable
element, tree is
expanded or
collapsed. Time
graph item expansion
is updated. Vertical
scroll bar updated.
For other entries, it
does nothing.

Selected entry is
changed. Table
selection is updated.
Vertical scroll bar
updated.

Previous or next
state is
selected.
Selected time is
updated in other
views.

Manual

Manual

Manual

Manual

Manual

Manual
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51

52

5.3

54

5.5

5.6

5.7

Align views

Show Legend

Reset Time
Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

Click on the Align
View Button, with
another time graph
view, eg the Control
Flow view opened
above or under

Click Show
Legend button

Click Reset
Time Scale
button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom
In/Out button

Select a time, and
click on the Add
Bookmark button

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

When it is pressed,
moving the line
between tree viewer
and time graph will
move the line of the
other view. If not
pressed, the line can
be moved without
affecting the other
views

The legend
dialog is opened
and can be
closed.

Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.
Previous or next
state is
selected.
Selected time is
updated in other
views.

Selected entry
is changed in
table and time
graph. Vertical
scroll bar
updated.

Time range is
zoomed in and
out, relative to
center of
selection or
window. States
are updated and
new time range
is propagated to
other views.

The bookmark is
added and is
displayed in the other
views as well (if
enabled)

Manual

Manual

Manual

Manual

Manual

Manual

Manual
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5.8

5.9

5.1

5.12

6.1

6.2

6.3

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

Synchronization'

Time
synchronization
Window range
synchronization

Selection range
synchronization

Add more
bookmarks, then click
on the next/previous
marker buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark
button

Click on the down
arrow at the extreme
right of the view, then
expand Show
markers and uncheck
the Bookmarks box

Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

Select a new window
range in another view

In any other
view that
supports
selection range
synchronization,
select a new
range.

3.0.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

The time graph view
navigate between the
bookmarks, States
are updated and time
selection is
propagated to other
views. When on a
bookmark, the Add
bookmark buttons
changes to Delete
bookmark

The bookmark is
deleted from all views

All remaining
bookmarks disappear
from the view, but
remain in other views
where the they are
enabled

The bookmarks come

back

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to
include it.

Window range
is updated.

Selection is
highlighted. If
the left time (T1)
of selected time
range is outside
the current
range, then
window range is
updated to
include it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Bookmarks are not hidden by the markers' contextual menu, but are hidden by the view's contextual menu
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Section

Flame Graph

Target: Windows 7 64 bit

Step
0
1

Test Case
Download the test resources

Preparation

Open TMF Flame Graph View

Import generic trace

Import cyg-profile trace

Import cyg-profile-fast trace

Manage View

Pass
19

Action

Download this

Use menu
Window — Show
View — Tracing
— Flame Graph

Import a trace
that does not have
any call stack
information, like
a standard kernel
trace

Import the trace
in the "trace"

directory of the
downloaded zip

Import a trace in
the "trace-fast"
directory of the
downloaded zip

3.0.0-TraceCompassTestCases - FlameGraphView

Fail

Verification

Verify that 'Flame
Graph View' view
1s shown

Verify that
nothing is shown
in the view

Verity that the
Flame Graph
View is populated
with some
callers/callees
information.

Verity that the
Flame Graph
View is populated
with some
callers/callees
information.

To Do
0
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

Comment

Comment
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2.1

2.2

23

24

2.5

2.6

Close view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Restart

Close the 'Flame
Graph' View

Use menu
Window — Show
View — Other ...
— Tracing —
Flame Graph

3.0.0-TraceCompassTestCases - FlameGraphView

Flame Graph'
view is removed
from perspective

Flame Graph'
view is displayed
and re-populated

Verity that view

is populated with
Open "trace(- callers/callees
fast)" trace information
1) Close 'Flame
Graph' view
2) Open
"glxgears-cyg-
profile(-fast)"
trace located in ~ Verify that view
the git in ctftest  is populated with
3) Open 'Flame  callers/callees
Graph' view information
Open Experiment Verify that view
with 2 or is populated with
moreFlame Graph all callers/callees
traces. information
(You can use both (separated by
traces) trace).

Verity that view
Restart Eclipse  is populated with

with Flame Graph callers/callees

trace opened

from trace

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual
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3.0.0-TraceCompassTestCases - FlameGraphView

Verify that Flame
Close traces and  Graph view is
experiment one  cleared after
by one from the  closing the last
2.7 Close all traces editor tab trace Manual

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph
traces. Then

select 'Sort The view is
threads by thread sorted by thread
3.1 Thread name sorting name' name. Manual

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph
traces. Then

select 'Sort The view is
threads by thread sorted by thread
3.2 Thead id sorting id' id. Manual

Select arandom  Selected time line
time in another  is not updating.
4.1 Time synchronization view Nothing happen. Manual
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4.2 Go to maximum

4.3 Go to minimum

Function name import

3.0.0-TraceCompassTestCases - FlameGraphView

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
maximum'

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
minimum'

1. Open the 'Call
Stack' view with
the 'Flame Graph'
view and the cyg-
profile trace
opened

2. Import 'cyg-
profile-mapping.
txt' as mapping
text file

- The 'Call Stack'

view is populated

- The call stack

view is

synchronised to

the range of the

maximum call

duration of the

'Flame Graph'

selected entry Manual

- The 'Call Stack'

view is populated

- The call stack

view is

synchronised to

the range of the

minimum call

duration of the

'Flame Graph'

selected entry Manual

Both 'Call Stack'
and 'Flame Graph'
views display
function name
instead of
function address.

SWTBot
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3.0.0-TraceCompassTestCases - FlameGraphView

Hover mouse in
time graph over Tool tip shows
5.1 Mouse hover (empty region) empty region depth only SWTBot

Tool tip shows
Total time and
Hover mouse in self times with
time graph over standard
Mouse hover (state) state statistics. SWTBot
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3.0.0-TraceCompassTestCases - Bug Reports

Section
Bug Reports

Test Case Bug Title

[TMF] Sequence Diagram Overview feature
Sequence Diagram 5.23 not working well on recent platform versions

LTTng 2 - Memory
Analysis 3.7, 3.8, CPU
Analysis 4.10, 4.11

LTTng 2 - Memory
Analysis 4.3, CPU
Analysis 6.3,
XmlAnalysis 7.3

LTTng 2 - Memory
Analysis 4.1, CPU
Analysis 6.1

[TMF] Status bar is not updated when
selecting time range in XY charts

[TMF] Time range selection outside current
range should update current range in time
graph views

[TMF] Time selection outside current range
should update current range in xy charts

[TMF] Original experiment reappears after
rename and copy

[Ittng rcp] Opening a second trace with --open
activates the wrong editor

Sequence diagram interaction tooltip is hard to
read on Ubuntu

Project View 6.5
RCP 1.4

Sequence Diagram 3.1

Button gets disabled in print dialog of
Sequence Diagram 5.24 sequence diagram after clicking on it

Memory analysis 2.4/
CPU Analysis

Control view 17.9

[TMF] XY chart view is cleared after being
filled when restarting or opening a trace

NPE trying to destroy a session

SWTEXxception widget is disposed trying to
import trace from Control view

Import to experiment will swallow exceptions
IOException in FlatArray.insert

Deleting a project with the delete key does not
Project Explorer 3.21 work

Control view 17.9
Project view
Time Chart 2.3

LTTng 2.0 - Memory
Analysis 3.3, 4.2, 4.3, UST Memory Usage view causes SWT invalid
4.4 thread access when navigating in trace

# Bug Reports
14

Found Bug Report

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0
1.0.0

1.0.0
1.1.0
1.1.0

2.0.0

23.0

https://bugs.eclipse.org/bugs/show_bug.cqi?id=436442

https://bugs.eclipse.org/bugs/show_bug.cqi?id=436853

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888

https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461

https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523

https://bugs.eclipse.org/bugs/show_bug.cqi?id=455546

https://bugs.eclipse.org/bugs/show_bug.cqi?id=467751
https://bugs.eclipse.org/bugs/show_bug.cqgi?id=469424

https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425

https://bugs.eclipse.org/bugs/show_bug.cqi?id=476475

https://bugs.eclipse.org/bugs/show_bug.cqi?id=476487

https://bugs.eclipse.org/bugs/show bug.cgi?id=486505

https://bugs.eclipse.org/bugs/show_bug.cgi?id=513013

# Open # Fixed

13

1

Status

Open

Open

Open

Open
Open
Open
Open
Open

Open
Open

Open
Open
Open

Open

_ Fixed

Enhancement
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=476487
https://bugs.eclipse.org/bugs/show_bug.cgi?id=486505
https://bugs.eclipse.org/bugs/show_bug.cgi?id=513013

